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Thank you for purchasing this PENTAX Digital Camera.

This is the manual for “PENTAX PHOTO Browser 3” and “PENTAX PHOTO Laboratory
3” software for your Windows PC or Macintosh for enjoying images created with your
camera. Please read the separate camera operating manual and this manual before
using your camera, “PENTAX PHOTO Browser 3", or “PENTAX PHOTO Laboratory 3”,
in order to get the most out of all the features and functions.

Keep the camera operating manual and this manual safe, as they can be valuable tools
in clarifying and helping you to understand all the camera capabilities.

Regarding copyrights

Images taken using this camera that are for anything other than personal enjoyment cannot
be used without permission according to the rights as specified in the Copyright Act. Please
take care, as there are even cases where limitations are placed on taking pictures even for
personal enjoyment during demonstrations, performances or of items on display. Images
taken with the purpose of obtaining copyrights also cannot be used outside the scope of
use of the copyright as laid out in the Copyright Act, and care should be taken here also.

Regarding trademarks

PENTAX, K-m/K2000 and smc PENTAX are trademarks of HOYA CORPORATION.
PENTAX PHOTO Browser, PENTAX PHOTO Laboratory and SDM are trademarks
of HOYA CORPORATION.

Microsoft and Windows are registered trademarks of Microsoft Corporation in the
United States and other countries. Windows Vista is either a registered trademark or
trademark of Microsoft Corporation in the United States and/or other countries.
Macintosh and Mac OS are trademarks of Apple Inc., registered in the U.S. and other
countries.

22 SDHC logo is a trademark.

This product includes DNG technology under license by Adobe Systems
Incorporated.

[ The DNG logo is either registered trademarks or trademarks of Adobe Systems
Incorporated in the United States and/or other countries.

All other brands or product names are trademarks or registered trademarks of their
respective companies.

Regarding PictBridge

PictBridge allows the user to connect the printer and digital camera directly, using the
unified standard for the direct printout of images. You can print images directly from the
camera through a few simple operations.

Disclaimer

HOYA is not responsible for any damages resulting from the direct or indirect use of
this software or repercussive damages, damage to data, programs or other intangible
property, loss of profit or anticipated profit, or dispute with a third party resulting from
the use of this software.

The specifications of this software are subject to change without notice.

® Symbols used in this manual have the following meanings:

L | Gives information that is useful to know.

W Gives cautions and notes about the operation.

The screen pictures shown in this manual may differ depending on the type of computer used.
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Enjoying Your Digital Camera Pictures

D You can use a computer to organize and edit the pictures captured with
your digital camera.

Connect your camera directly to a
PictBridge-compatible printer using the
USB cable. (Not available on *éa¢D.)

Your computer is...

« equipped with a standard USB
interface.

« using Windows XP/Windows Vista
or Mac OS X Ver. 10.3 or later.

View and record images on
AV equipment

Connect your cameratoa TV,
DVD recorder or other audiovisual
equipment using an AV cable to
view and/or record images.

Connect your camera
to a computer using

the USB cable to copy
the camera images to
a computer.

You can transfer your

images using a built-in

card slot + PC card

adapter or a card reader.

« Remove the card from
the camera. When
transferring images on
the card to a computer
with another device,
make sure to review the
user manual
accompanying that
device.

Use your photo store |

You can have prints made from
images recorded on your card
at a photo store.

« Set DPOF settings on your
camera, and get prints from
your photo store.

« Select the images for prints.



[l

| Use your image data

You can use your e-mail software to attach and send images
by e-mail, or post the images on your website.

* See the operating manual of your e-mail
software for details on how to make
attachments to e-mails.

+ See the operating manual of the software

you are using for details on how to use

images on your website.

Use your printer

T

PENTAX PHOTO Browser 3 (p.18 - p.69) —) /
PENTAX PHOTO Laboratory 3 (p.70 - p.102) S
 View images * Organize and save images
* Printimages * Rename all You can use your printer to
« Save all image data print images transferred to
» PENTAX-specification RAW file processing* your computer. )

Some printers can print
Use a commercially-available image editing directly from SD Memory

software to perform image editing operations. Cards.
« For details, see the

operating manual of the

* You can also perform file processing ~ Printer you are using.
operations for DNG files taken with
PENTAX digital cameras and DNG
files converted with PENTAX PHOTO

Browser 3.
| Save your image data
o
= Images transferred to the computer can

be saved onto a CD-R or other media.




Provided Software

The provided CD-ROM (S-SW84) contains the following software:
+ PENTAX PHOTO Browser 3
* PENTAX PHOTO Laboratory 3

L=~  This manual describes PENTAX PHOTO Browser 3 and PENTAX PHOTO
"= Laboratory 3 with screen images from Windows XP.
The operation of these software applications is nearly the same on Macintosh
with the exception of some keys. For information on Macintosh-specific
instructions, see the sections labeled “For Macintosh” or the online help.

Software Provided

PENTAX PHOTO Browser 3

(9 languages: English, French, German, Spanish, Italian, Russian,
Chinese [traditional and simplified], Korean, Japanese)

PENTAX PHOTO Browser 3 is software for viewing, printing and
managing images taken on your digital camera and saved on your
computer.

Files with extensions .bmp (BMP), .jpg (JPEG), .pef (Files recorded in
PENTAX'’s exclusive digital-camera RAW format. Hereafter “PEF”), .pct
(PICT), .png (PNG), .tif (TIFF) and .dng (DNG) are supported.

PENTAX PHOTO Browser 3 can perform the following tasks:

» Save image files under the same or a new name, change file names and
file types, copy, cut, paste, rotate and delete.

» Create new folders, change folder names, copy, cut, delete and paste.

» Save image data list.

» Check image data.

* View PEF files and DNG files easily.

* Print images.

You can also start PENTAX PHOTO Laboratory 3 from within PENTAX
PHOTO Browser 3.



PENTAX PHOTO Laboratory 3

(9 languages: English, French, German, Spanish, Italian, Russian,
Chinese [traditional and simplified], Korean, Japanese)

This application supports a number of image processing functions for use
with PEF and DNG files including data conversion, color adjustment, and
image compensation, and further allows you to save these images in
formats compatible with other commercial image browsing and editing
software. You can also print PEF and DNG files.

PENTAX PHOTO Laboratory 3 can also be run as a standalone
application.

m You can only perform image processing operations for DNG files taken with
PENTAX digital cameras and DNG files converted with PENTAX PHOTO
Browser 3.

‘-memo DNG (Digital Negative) is a general-purpose, publicly-available RAW file
format designed by Adobe Systems.

System Requirements

We recommend the following system requirements to install PENTAX
PHOTO Browser 3 and PENTAX PHOTO Laboratory 3, transfer images
from your camera to a computer and process images.

Windows System Requirements

Computer with Windows XP (Home Edition/Professional/x64 Edition) SP2

or Windows Vista preinstalled (USB 2.0 port must be standard equipment)

* Your camera can be connected to your computer with a USB cable to
transfer images with Windows 2000. However, PENTAX PHOTO
Browser 3 and PENTAX PHOTO Laboratory 3 are not available.

« CPU : Pentium 4 or higher

(Pentium 4 2.0 GHz or higher recommended)
* RAM : 1.0 GB or more
* Monitor : 1280%1024 pixels or more with 24-bit full color

(approximately 16.77 million colors)
* Free Disk Space : 250 MB or more (500 MB or more recommended)



W We recommend using AC adapter (sold separately) when the camera is
connected to the computer. If the battery becomes depleted during image
transfer, the image data or SD Memory Card may be damaged.

Macintosh System Requirements

Macintosh with Mac OS X 10.3 or later preinstalled (USB 2.0 port must be

standard equipment)
* Your camera can be connected to your computer with a USB cable to
transfer images with Mac OS X 10.2. However, PENTAX PHOTO
Browser 3 and PENTAX PHOTO Laboratory 3 are not available.
+ CPU : PowerPC G5 or higher
(Dual CPU or Intel Core processor recommended.
Universal Binary format)

* RAM : 1.0 GB or more

* Monitor : 1280%1024 pixels or more with 24-bit full color
(approximately 16.77 million colors)

» Free Disk Space : 250 MB or more (500 MB or more recommended)

m We recommend using AC adapter (sold separately) when the camera is
connected to the computer. If the battery becomes depleted during image
transfer, the image data or SD Memory Card may be damaged.



Installing the Software

Here is the procedure for installing PENTAX PHOTO Browser 3 and
PENTAX PHOTO Laboratory 3.

PENTAX PHOTO Browser and PENTAX PHOTO Laboratory can
overwrite earlier versions of this software.

Make sure to install PENTAX PHOTO Browser 3 and PENTAX PHOTO
Laboratory 3 on the provided CD-ROM (S-SW84) in order to use RAW
files shot with the IC-m1/I€ 2000 .

When multiple accounts have been setup in Windows XP/Windows Vista
or Mac OS X, log on with an account that has administrative rights before
installing the software.

When Using Windows

’ Turn your computer on.

Close any other software that is open.

2 Place the provided CD-ROM (S-SW84) into the CD-ROM
drive on your computer.

The PENTAX Software Installer screen appears.

« If the PENTAX Software Installer screen does not appear
Display the PENTAX Software Installer screen following the steps below.
1) Click [My Computer] from the start menu.
2) Double-click the [CD-ROM drive (S-SW84)] icon.
3) Double-click [Setup.exe].

3 You can choose the languages
from the displayed screen. PENTAX scrvare mstr

[ T T
The software selection screen [ e=ol
appears. Craraiem)— (CP7EEin

Deutsch e
_Esparol | | seincec
Italiano | | fEfkR

| " SILKYPIX"




4 Click [PENTAX Digital Camera
Utility].

_ @

5 Select the desired language in  pyr— =
the Select Language screen Pl i e e oty o i 152
and click [OK].

Japanese
French

rman
Fodern Spanish
Ttalian

O Gancel |

i~ Some operating environments select the language automatically. Continue
= with the installation in step 6. The installer starts.

ﬁ The installer starts. Click s ®
[Next]. B =

| Camera Uty Setup.
1l FENTAX Digtal

Follow the instructions on the screen @ Ei
and continue with the installation. ol

52 any progr .
ih he Setp progiam

wal prtected by copyrigh |
iner

==




Product Registration on the Internet

To better serve you, please take a moment to register your software.

Please click [Product Registration] on the
software selection screen in step 4 (p.8).
A world map for Internet Product
Registration is displayed. If your computer
is connected to the Internet, click the
displayed country or region and then
follow the instructions to register your
software.

When Using Macintosh

’ Turn on your Macintosh.

Close any other software that is open.

2 Place the provided CD-ROM (S-SW84) into the CD-ROM

drive on your Macintosh.

3 Double-click the [CD-ROM
drive (S-SW84)] icon.

The contents of the CD-ROM are
displayed.

LOBRLAIRBQ<® W




4 Double-click the [PENTAX
Installer] icon.

The PENTAX Software Installer
screen appears.

anon ® S-swa4
(cr)E=m[#]
PENTAX \ns;a\ler
|
L

5 You can choose the language
from the displayed screen.

The software selection screen

®00

PENTAX sorvare tater

- _

=

appears. | Frangais | Pycekuit
| Deutsch | BAE
| Espafiol | iRy
| Maliano | BtERT
N L SILKVPIX®
ﬁ Click [PENTAX Digital Camera [e== e )
Utility]. PENTAX somars rsr =)

Follow the instructions on the screen
and continue with the installation.

Product Registration on the Internet

[ _ S

> PENTAX Digital Camera Utility

ot o> U Y

5, Product
 rogistration

To better serve you, please take a moment to register your software.

Please click [Product Registration] on the software selection screen in
step 6. Next, follow the instructions on the screen to register your software

(p-9).



Saving Images on Your Computer

Here is the procedure for saving images captured with your digital camera
onto your computer.

This section describes the method for saving images by connecting your
camera and computer with the USB cable, as well as other methods.

Saving Images by Connecting Your Camera
and Computer (For Windows)

Setting [USB Connection] on the Camera to [PC]

IC-m/IC2000 is used as an example here.

’ Press the MENU button on the camera.
The [€3 Rec. Mode 1] menu or the [[=] Playback 1] menu appears.

2 Press the four-way controller (») to display the
[N Set-up 2] menu.

3 Use the four-way controller (A ¥) to select [USB
Connection].

4 Press the four-way controller (»).

A pull-down menu appears.

- v
5 Use the four-way controller (A V) BIE~ 1 23
to select [PC] Brightness Level 0
LCD Color Tuning
[USB Connection] settings depend on the Video Output NTSC
connected device. _USB Connection 4
K Auto Power Off
When connecting to a computer: Select battery LAUTO
— : Reset
[PC] =USB 2.9 (Hi-Speed USB WER) Cancel TOOK
compatible)

When printing with a printer:
[PictBridge] (only for compatible printers)



_ @

6
%

Press the OK button on the camera.

Do not connect the camera to your computer while [PictBridge] is selected for
the [USB Connection].

Connecting Your Camera to Your Computer

1
2

J

L

memo,

Turn your computer on.

Turn off your camera and use the USB cable to connect
your camera and your computer.

Confirm that an SD Memory Card is inserted into your camera.

Turn your camera on.

The camera is recognized as a [Removable Disk] in [My Computer].

« If the [Removable Disk Drive] dialog appears when the camera is turned on,
select [Open folder to view files using Windows Explorer] and click [OK]. The
window in step 3 on p.13 appears.

* When using Windows XP, if the SD Memory Card has a volume label, the
content of the volume label name appears instead of [Removable Disk]. A
new unformatted SD Memory Card may show the manufacturer name or
model number.



Saving Camera Images on Your Computer

Windows XP is used as an example here.

T Click [My Computer] from the
start menu.

BGY

§6204

2 Double-click the [Removable
Disk] icon.

3 Double-click the [DCIM] icon.

The [xxxPENTX] (xxx is a three-digit
number) folder appears.

The camera image files are in this
folder.

‘ﬁe?o When the method for assigning folder names is set to [Date], the [xxx_MMDD] folder
= (where MMDD is the shooting date) appears. (p.224 of the camera Operating Manual)

4 Drag and drop the [xxxPENTX]
or the [xxx_MMDD] folder to
the desktop or any desired
folder, such as the [My
Documents] folder.

The camera images are saved on your
computer as an entire folder.

-

1=~ Images can also be saved using the [Easy Image Transfer] function in PENTAX

= PHOTO Browser 3. (p.30)




Disconnecting Your Camera from Your Computer

Windows XP is used as an example here.

1 Double-click the % [Safely
Remove Hardware] icon in the

task bar.
The [Safely Remove Hardware]
screen appears. g e
2 Confirm that [USB Mass
@ Storage Device] is selected e
and then click [Stop].
The [Stop a Hardware device] screen
appears.
[ Display device components.
3 Select [USB Mass Storage % S1op 2 ardwars device X
Device] and click [OK]_ Confim devices to be stopped, Choose OK to cortinue.
e
A message appears indicating that the 05 s St O
hardware can be safely removed. b 152D
Ok Cancel

4 ciick [Close].

5 Turn off the camera and
disconnect the USB cable from
your camera and computer.

L~  The USB mass storage device will not stop when the files stored on the
removable disk are in use by applications.



Saving Images by Connecting Your Camera
and Computer (For Macintosh)

Setting [USB Connection] to [PC]

Refer to p.11 for settings procedures.

Connecting the Camera and Macintosh

’ Turn on your Macintosh.

2 Turn off your camera and use the USB cable to connect
your camera and your Macintosh.

Confirm that an SD Memory Card is inserted into your camera.

Vi ]

3 Turn your camera on.
Your camera is recognized on the desktop as [NO_NAME] (or the
volume label of the SD Memory Card if one is registered).
You can change the name of the SD Memory Card.
When the iPhoto screen appears, close it.



Mac OS X (ver. 10.3) is used as an example here.

Saving Camera Images on Your Macintosh

’ Double-click the [NO NAME]
icon on the desktop.

2 Double-click the [DCIM] icon. s

D The [xxxPENTX] (xxx is a three-digit ] i
number) folder appears. |

The camera image files are in this
folder.

LOAQUAIBEQ <% IW

"memo When the method for assigning folder names is set to [Date], the [xxx_MMDD]
folder (where MMDD is the shooting date) appears. (p.224 of the camera
Operating Manual)

3 Double-click the [Macintosh S ——
HD] icon on the desktop. e

This opens the [Macintosh HD]
volume.

<

LOBQALAIRBQ<® W



4 Drag the [xxxPENTX] or
[xxx_MMD] folder to L
[Macintosh HD] volume or any \| Z 0 s
other volume or folder. ' \»

The complete folder, containing all
images, is saved to the destination
volume or folder.

KOBQUDIBBEQ < ® KW

1~ Images can also be saved using the [Easy Image Transfer] function in PENTAX

PHOTO Browser 3. (p.30)

Disconnecting Your Camera from Your Macintosh

’ Drag [NO_NAME] (or the e e e
volume label name on the SD EI
Memory Card) on the desktop
to the trash can. ‘

“OBQUEIImEQ % {u]

2 Turn off the camera and disconnect the USB cable from
your camera and Macintosh.

Other Methods for Saving Images

Use a card reader or card adapter to send image files directly to your
computer from an SD Memory Card with saved images without connecting
your camera and your computer with a USB cable. (p.30)

For details, please refer to the user’s manual for your computer or card
reader.



PENTAX PHOTO Browser 3

This section describes opening and closing PENTAX PHOTO Browser 3 and
viewing the PENTAX PHOTO Browser window, and explains its functions.

Opening PENTAX PHOTO Browser 3

For Windows

’ Select the start menu on the desktop.

2 Select [All Programs] -[PENTAX
Digital Camera Utility] -
[PENTAX PHOTO Browser].

PENTAX PHOTO Browser 3 is opened
and the PENTAX PHOTO Browser

D window appears.

® Closing PENTAX PHOTO Browser 3
Select [Exit] from the [File] menu.

For Macintosh

’ Double-click the [PENTAX Digital Camera Utility] folder in
[Applications] on the hard disk.

2 Double-click the [PENTAX
PHOTO Browser] program icon.
PENTAX PHOTO Browser 3 is opened

and the PENTAX PHOTO Browser
window appears.

(2 PENTAX Digital Camera Utlty =
- a v

uuuuuuuuuuuuuu PENTAX PHOTO Laboratory

2 tems, 68,84 GB waiable

® Closing PENTAX PHOTO Browser 3
Select [Quit PENTAX PHOTO Browser] in [PENTAX PHOTO Browser] on
the desktop menu bar.



About the PENTAX PHOTO Browser Window

This section explains the PENTAX PHOTO Browser window layout,
names and functions.

Menu bar Tool bar Thumbnail pane
Address bar

Folder tree pane Checked images pane

23 £ ENTAX PHOTO Brows r,
Fie [Edt view Tool Help

0-©«

pddess [C
[@F Desion

& 03 My bocuments
2y usc
(& mypitues
£ toopenT
9y Computer

3 My Network Places = O | Eas O | Em O
IMGP1B30PEF IMGF1E31 PEF IMGP1632 PEF IMGP1B33PEF

R/200% X200k X208 XX/2008

104314 AM 114310 AM 124314 P 1:43.08 PH

(emu) O | B X (0 ]

WGPIEUREE | WGPISHREE | INGPswPEF ipre37rEF
HARA200K HA%/200K HO%/200K HAR200%
et e R R o
lrstone  ORIHSOED.. Rowddpics  7pcs  Fhadied
Feckiongn oo Gy i =
Shutter speed 1/30sec. Exposure compen... 0.0 Drive made. Single-frame shoo.
Aperture F4.0 ‘Shadow Comnpens... On Flash made Flash off
Cremose ameleicosne  Asotsis ot Shie iF =
e e
Color Temperature - Image tone Matural Shiake Reduction Enabled
Foctmens i Frmwncn.. o v 1.0
Finetune M-G - Hue o ‘Shooting Date/Tim... X/X/200% 10:13:13
Expand Dynamic No. Fine Sharpness Mo
< >
1 | 14.17 MB | Disk free space 4.5 GB. Local Disk Drive.
Preview pane Image data pane Status bar

® Menu bar (p.23)
® Tool bar (p.27)

® Address bar
The address of the currently displayed folder appears here.

® Folder tree pane

Internal data on your computer appear here as a folder tree. Select the
folder containing saved image files here.

Also, the Folder tree pane handles operations such as creating new
folders, deleting folders and moving/copying folders.




® Thumbnail pane

Files in the folder selected in the Folder tree pane appear here. Select
from five file display methods. When a thumbnail image is selected in the
Thumbnail pane, the image appears in the Preview pane and the image
data appear in the Image data pane.

® Checked images pane

All images with check marks in the Thumbnail pane are displayed here.
Switch between Thumbnails and Details by right-clicking the Checked
images pane. When a thumbnail image is selected in the Checked images
pane, the image appears in the Preview pane and the image data appear
in the Image data pane.

® Preview pane
An image selected in the Thumbnail pane appears in this pane.

® Image data pane

The image data for the image selected in the Thumbnail pane appear here.
Place the cursor over a cell dividing line at the top of the pane and drag it to
resize the cell. (For Macintosh, drag at the applicable position to resize the cell.)
The following items appear (examples listed are for shooting with the
IC-miIK2000):

Data Contents Example

Lens name Shows lens type smc PENTAX-
FA 50mmF1.4

Focal length Focal length (in mm) 50mm

Shutter speed Shutter speed when shooting (in seconds) 1/250sec

Aperture Aperture value when shooting F8.0

Capture mode Capture mode when shooting Manual
Exposure

Metering mode Metering mode when shooting Multi-segment

White balance White balance mode Auto

Color temperature Color temperature (units: Kelvin) ™1 —

Fine tune A-B Amber - Blue fine tune ™ —

Fine tune M-G Magenta - Green fine tune ™1 J—

Sensitivity 1SO sensitivity when shooting 200

Expand Dynamic Range Expand Dynamic Range settings Off

High-ISO Noise Reduction High-ISO Noise Reduction settings Strong

Recorded pixels Number of recorded pixels 3872x2592

Quality Recorded quality Better

*1: Setting details when shooting or processing details when using PENTAX
PHOTO Laboratory 3 appear.



Data Contents Example
Exposure compensation Exposure compensation 0.0
Shadow Compensation Compensation of gradation of shadow On
Autofocus mode Autofocus mode when shooting Single AF
Autofocus area mode  Autofocus area mode when shooting ~ Automatic
Color space Color space mode sRGB
Image tone Photo finish settings Bright
Saturation Saturation settings 0
Hue Hue settings 0
Sharpness Sharpness settings 0
Fine Sharpness Fine Sharpness settings Off
Contrast Contrast settings 0
Filter Effect Filter Effect settings ————-
Toning Toning settings -----
Drive mode Drive mode settings when shooting Single-frame
shooting
Flash mode Flash mode settings when shooting Flash Off
Bracket Exposure bracket settings when Off
shooting
Extended Bracket Extended bracket settings when —
shooting™
Multi-exposure Multi-exposure settings when shooting Off
Shake Reduction Shake Reduction Setting On
Firmware/Software Version of the software when images K-m
version were last saved "3 Ver 1.00
Shooting Date/Time Date and time of shooting 7/7/2008
10:00:00
Camera model Camera name PENTAX K-m

*2: The range of the variable appears after the name of the item, such as
[Saturation], set during shooting.
*3: Information on the camera firmware appears for captured images.

o Status bar

The status of PENTAX PHOTO Browser 3 appears.
The following items appear:
» Number of objects in the selected folder, total folder size (not including

subfolders) or number of selected objects and total size

» Available disk space for selected drive
* Progress status when loading thumbnails

« |dentification of local disk, removable disk and network




Showing/Hiding Panes and Bars

Show/hide panes and bars using the [View] menu (p.24). A check is
displayed in the box (/& ) in front of the item for currently showing items.
Check these to show and uncheck to hide.

Alternatively, click the [Close] button (1= ) on the top right of each pane to
close.

Removing and Moving the Tool Bar and Address Bar

The Tool bar and Address bar can be removed or moved from the Browser
screen.

® Remove the Tool bar and Address bar

To remove a bar, double-click the left edge of the bar in the Browser
screen. Alternatively, click the left edge of the bar and drag to the
Thumbnail pane or Folder tree pane.

The bar is removed from the Browser screen.

o Add the Tool bar and Address bar in the Browser screen

Double-click the bar to return the bar to the original location. Alternatively,
drag the bar back to the original location.
The bar returns to the Browser screen.

® Move the Tool bar and Address bar

Click the left edge of the bar and drag to the new location.
The bar is moved to the new location.

m The Address bar can only be moved below the Menu bar, next to the Tool bar,
or to the top/bottom of the Thumbnail pane.

I~  Select [Default Position] on the [View] menu or click (Default Position) on
the Tool bar to return the bar to its default position.



Removing and Moving Panes

The Folder tree pane, Preview pane, Image data pane and Checked
images pane can be removed from the Browser screen.

® Remove panes

To remove a pane, double-click the top edge of the pane in the Browser
screen. Alternatively, click the top edge of the pane and drag to the
Thumbnail pane.

The pane is removed from the Browser screen.

® Add a pane in the Browser screen

Double-click the Title bar of the pane to return to the original location.
Alternatively, click the Title bar and drag the pane back to the original
location.

The pane returns to the Browser screen.

® Move panes

To move a pane, select pane and drag to the new location.
The pane is moved to the new location.

1=~  Select [Default Position] on the [View] menu or click (Default Position) on
the Tool bar to return the bar to its default position.

Menu Bar

This executes functions or sets various settings of PENTAX PHOTO
Browser 3.
For Macintosh, the Menu bar appears at the top of the desktop.

[File] menu

Create New Folder This creates a new folder in the location specified on
the Folder tree pane. (p.51)

Open This opens the selected folder. For an image
selected in the Thumbnail pane, it displays the image
in a new Main image view window.

Close All This closes all images open in the Main image view
windows.

Rename This changes the name of the selected file or folder.

(p.49)




[File] menu

Rename All This changes the names of all selected files. (p.50)

Page Setup This sets printing options such as margins, headers/
footers, and number of copies. (p.61)

Print This prints the selected image file. (p.57)

Properties The properties of the selected file or folder appear.
(p.53)

Exit This closes PENTAX PHOTO Browser 3.
(For Macintosh, select [Quit PENTAX PHOTO
Browser] on the [PENTAX PHOTO Browser] menu.)

[Edit] menu

Undo This undoes the previous file operation.

Cut This prepares the selected file or folder to be moved
to a different location. (p.47)

Copy This copies the selected file or folder. (p.47)

Paste This copies the cut or copied file or folder into the
selected folder. (p.47)

Delete This deletes the selected file or folder. When a folder

Move to Folder
Copy to Folder
Check Selected Image

Uncheck Selected Image
Uncheck All

Select All

Invert Selection

is deleted, all files in the folder are also deleted.
(p.49)

This moves the selected file to another folder.
This copies the selected file to another folder.

This checks the selected file. The checked file is
displayed in the Checked images pane. (p.33)

This unchecks the selected file.
This unchecks all image files.
This selects all files within the currently open folder.

This unselects all selected files and selects all
unselected files within the currently open folder.

[View] menu

Tool Bar

Folder Tree
Preview
Address Bar
Status Bar
Image Data
Checked Images
Default Position

This shows or hides the Tool bar.

This shows or hides the Folder tree pane.

This shows or hides the Preview pane.

This shows or hides the Address bar.

This shows or hides the Status bar.

This shows or hides the Image data pane.

This shows or hides the Checked images pane.
This returns each pane to its default position.




[View] menu

Filter

Sort by

Thumbnail Caption

Thumbnail (Smallest)
Thumbnail (Small)
Thumbnail (Medium)
Thumbnail (Large)
Details

Detailed View Options

Go To

Slideshow

This sets the type of file that appears in the

Thumbnail pane. Select from the following four items:

PENTAX Images : Images captured with your
PENTAX camera

Other Images  :Images other than those captured
with your PENTAX camera
(JPEG, TIFF, BMP, PNG, PICT)

Folders : Folders

Others : Files that PENTAX PHOTO
Browser 3 does not support

This specifies the order in which files and folders
appear in the Thumbnail pane and specifies
ascending or descending order.

You can select from File Name, File Size, File Date/
Time, File Type, Shooting Date/Time, Image Size,
Camera Name, Lens Name, Checkmark and Lock
Status.

This sets the caption of file that appears in the
Thumbnail pane. File Name, File Date and File Time
appear by default.

The smallest size thumbnail appears in the
Thumbnail pane.

A small size thumbnail appears in the Thumbnail
pane.

A medium size thumbnail appears in the Thumbnail
pane.

A large size thumbnail appears in the Thumbnail
pane.

Image details appear in the Thumbnail pane without
an image.

Sets the information displayed in the Thumbnail pane
when set to [Details].

Select [Back] to return to the previously opened
folder, [Forward] to move forward one folder, and
[Up] to move up one folder in the directory tree.

Selected or checked images appear in order. (p.54)
If only one image is selected or no images are
selected (click the background of the Thumbnail
pane), all images in the current folder are displayed
in order.




[Tool] menu

Save Image Data List

Rotate
Extract JPEG

Save as DNG
Easy Image Transfer

PENTAX PHOTO
Laboratory

PENTAX REMOTE
Assistant !

Use the check boxes to save the image data from
multiple folders into one CSV format file. If no images
are selected or checked, all the image data in the
current folder are saved. (p.52)

Rotates the selected image 90° left or right. (p.34)
Extracts the JPEG data for browsing from a selected
PEF file or DNG file (shot with /KK70D/IK 20D/
IK200D/IKK-m/IKC2000) and saves it as a
separate file.

Converts a selected PEF file into a DNG RAW file.
Automatically searches for DCF images recorded in
the camera or SD Memory Card connected to the
computer and copies the images to the computer.
(p.30)

This starts PENTAX PHOTO Laboratory 3. You can
specify the image files to be opened from PENTAX
PHOTO Browser 3. (p.79)

This starts PENTAX REMOTE Assistant.

PENTAX REMOTE Assistant can be used by
installing it in the same folder as PENTAX PHOTO
Browser 3.

Options This sets various settings for PENTAX PHOTO
Browser 3. (p.64)

[Help] menu

Help Topics This shows PENTAX PHOTO Browser 3 help
contents.

Index This shows PENTAX PHOTO Browser 3 help index
search. (This command is not available for
Macintosh.)

What's This? This shows pop-up tips when an icon or command

About PENTAX PHOTO

Browser

button is clicked.

This shows PENTAX PHOTO Browser 3 version
information. (For Macintosh, select [About PENTAX
PHOTO Browser] on the [PENTAX PHOTO Browser]
menu.)

*1: PENTAX REMOTE Assistant 3 is included in the CD-ROM (S-SW75) provided
with the /(20D . PENTAX REMOTE Assistant can be used with /(20D/

K10D/*istD.



Tool Bar

Frequently used functions are provided as Tool bar buttons. You can
execute these functions easily from the Tool bar.

If, after resizing the Browser screen, part of the Tool bar is not visible, you
can click the downward pointing arrow on the right edge of the Tool bar to
select a tool that is not displayed.
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Number Icon (button) Content

1 This opens the previously opened folder.

Click the downward pointing arrow to the right of
the [Back] icon to display a history of previously
opened folders. (For Macintosh, hold down this
icon to display the history.)

This opens the folder which was open before
using the [Back] button.

Click the downward pointing arrow to the right of
the [Forward] icon to display a history of
previously opened folders. (For Macintosh, hold
down this icon to display the history.)
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3 This moves up one folder in the directory tree.
Up
4 This changes the names of all selected files.
g@ (p.50)
Rename All

This prints the selected image file. (p.57)
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This undoes the previous file operation.
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Number Icon (button)

Content

7 This prepares the selected file or folder to be
moved to a different location. (p.47)
Cut
8 This copies the selected file or folder. (p.47)
Copy
9 This copies the cut or copied file or folder into the
selected folder. (p.47)
Paste
10 This deletes the selected file or folder. (p.49)
Delete
11 The selected image file appears in the Main
@ image view window. (p.31)
View Image
12 Click  to select the type of file that appears in the
Thumbnail pane. Select from the following four
Filter items: _
PENTAX Images : Images captured with your
PENTAX camera
Other Images  :Images other than those
captured with your PENTAX
camera (JPEG, TIFF, BMP,
PNG, PICT)
Folders :Folders
Others :Files that PENTAX PHOTO
Browser 3 does not support
13 Click [+ to select the sort key and ascending/
descending order from the pull-down menu.
Sort by Thumbnails are sorted according to the selected
order.
14 The smallest size thumbnail appears in the
Thumbnail pane. (p.31)
Thumbnail
(Smallest)
15 A small size thumbnail appears in the Thumbnail
pane. (p.31)
Thumbnail (Small)
16 A medium size thumbnail appears in the

Thumbnail (Medium)

Thumbnail pane. (p.31)




Number Icon (button)

Content

17 A large size thumbnail appears in the Thumbnail
@ pane. (p.31)
Thumbnail (Large)
18 Image details appear in the Thumbnail pane
without an image.
Details
19 This returns the window layout of PENTAX
PHOTO Browser 3 to the default settings.
Default Position
20 Selected or checked images appear in order.
-
i (p.54)
Slideshow
21 This rotates the selected image 90° left or right.
Rotate
22 This saves additional file information for specified
image files in a single CSV-format file. (Additional
. file information can be saved only for PENTAX
Save Image Data List PHOTO Browser 3-compatible image files.) (p.52)
23 Automatically searches for DCF images recorded
in the camera or SD Memory Card connected to
the computer and copies the images to the
Easy Image Transfer computer. (p.30)
24 = This starts PENTAX PHOTO Laboratory 3. You
ﬂ can specify the image files to be opened from
PENTAX PHOTO PENTAX PHOTO Browser 3. (p.70)
Laboratory
25 This starts PENTAX REMOTE Assistant.
To start PENTAX REMOTE Assistant (Version 1)
or PENTAX REMOTE Assistant 3 when both are
iEN-I;A;(t REMOTE installed, select one from the drop-down list. After
ssista one is selected, click this icon to start the selected
Only for #iat D)/ PENTAX REMOTE Assistant version.
( K”,VO‘; ;;( 20D PENTAX REMOTE Assistant can be used by installing
it in the same folder as PENTAX PHOTO Browser 3.
26 This sets various settings for PENTAX PHOTO
Browser 3. (p.64)
Options
27 This shows PENTAX PHOTO Browser 3 help

Help Topics

contents.

@



Transferring Images

This function automatically searches for DCF images recorded in the
camera or SD Memory Card connected to the computer and transfers the
images to the computer.

Transferring Image Files from SD Memory Card

1

memo,

Check that the digital camera, SD Memory Card reader or
DCF-compatible removable disk is connected to your
computer, and then select [Easy Image Transfer] on the
[Tool] menu.

Alternatively, click the [G icon on the Tool bar.

The digital camera or DCF-compatible removable disk with image files is
recognized.

Select the drive with the images you want to transfer and
click [Next].

The message [Could not find DCF media.] appears if no digital camera or DCF-
compatible removable disk is connected to the computer or the connected
device has no image files.

Select the folder with the images you want to transfer and
click [Next].

After selecting [Transfer selected folder(s)], select a folder from the list.
To transfer all images in the selected drive, select [Transfer all images].

Select the destination folder and click [Transfer images].

To create a new destination folder, select the location where the folder is
to be created and click [New Folder].

After the images have been transferred, click [Finish].



Viewing Images

Display the images saved on your computer in the Preview pane or Main
image view window.

Displaying Thumbnail Pane Images in the Preview Pane

’ In the folder tree, select the folder containing the image
file to view.

Images in the selected folder appear as thumbnails in the Thumbnail
pane.
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I~ You can change the size of the thumbnail image. In the [View] menu, select
[Thumbnail (Smallest)], [Thumbnail (Small)], [Thumbnail (Medium)], or

[Thumbnail (Large)]. Alternatively, click the [F , [, | or [I] icon on the Tool
bar.

Z Select an image in the Thumbnail pane.

The selected image appears in the Preview pane.
When the Preview pane is right-clicked, the following menu appears.

Preview Previous Shows previous image.

Preview Next Shows next image.
Auto Size Fits image to the size of the Preview pane.
Fixed Size Shows image with the longer dimension of the image

fixed at 320 pixels (aspect ratio is maintained).
Life Size Shows image size at 100% zoom.




Images in the Checked image pane (p.19) can also be displayed in the Preview
pane.

L
memo

Displaying Thumbnail Pane Images in the Main Image View Window

Follow the steps below to open the Main image view window.

’ Select an image in the Thumbnail pane of the Browser
screen and click the [ icon on the Tool bar.

The Main image view window opens and the selected image appears.

i—memo » Multiple images may be selected in the Thumbnail pane and opened in the
Main image view window. When multiple images are selected, the Main
image view window may be set in [Options] to show all images in one window
or multiple windows (p.42). Images are shown in one window by default.
Images in the Checked images pane can also be displayed in the Main image
view window (p.33).
The following methods can also be used to open the Main image view window.
‘) — Select animage in the Thumbnail pane and then select [Open] on the [File]
menu.
— Select [Main Image View] on the menu after right-clicking an image in the
Thumbnail pane. (For Macintosh, display the menu by clicking the image
while holding down the control key.)
— Double-click an image in the Thumbnail pane.
— Drag and drop the image file from the Desktop to the opened Main image
view window.
— Select [Main Image View] on the menu after right-clicking an image in the
Checked images pane. (For Macintosh, display the menu by clicking the
image while holding down the control key.)
— Double-click an image in the Checked images pane.

® RAW file display

PENTAX PHOTO Browser 3 allows you to select between [Simple display]

and [Auto RAW display] when displaying RAW files in the Main image view

window. (p.68)

Simple display : The compressed data in the RAW file appear. Images
can be viewed quickly.

Auto RAW display : The RAW file is processed. It takes time to display the
RAW data, but the image quality is superior.
Select from three levels for the processing ratio on the
[Main Image View] tab of the [Options] dialog. (p.68)



Displaying Images in the Checked Images Pane

Each image thumbnail displayed in the Thumbnail pane (in the left column
of the list of thumbnails when [Details] is selected) shows a Check box
indicating whether an image is registered to the Checked images pane.
When this box is clicked to display a check mark, that image becomes a
“checked image”.

Each time the Check box is clicked, the check mark group switches among
Checkmark 1, Checkmark 2 and Checkmark 3. Alternatively, select an
image in the Thumbnail pane and then select a check mark group with
[Check Selected Image] on the [Edit] menu.

Checked images are registered to the tab corresponding to the check
mark group in the Checked images pane. Images stored in different
folders that are tagged with the same check mark are registered to the
same tab. The thumbnails in the Checked images pane are color-coded
according to the folder where the images are saved. There are seven
colors that are used for color-coding the thumbnails, and if there are
thumbnails from eight or more different folders with the same check mark,
the colors to indicate the folders are repeated. You can select from seven
colors using the [Options] dialog on the [Tool] menu.

When the Checked images pane is right-clicked, the following menu
appears. (For Macintosh, hold down the control key while you click the
pane.)

Item Description

Main Image View Opens the image in a Main image view window. Multiple
images may be opened simultaneously.

Slideshow Images in the Checked images pane are displayed in

Slideshow. Opens the Slideshow screen and Slideshow
control panel.

PENTAX PHOTO PENTAX PHOTO Laboratory 3 starts. Select a RAW file
Laboratory in the Checked images pane and click this button to
open the image in PENTAX PHOTO Laboratory 3.

Save Image Data List  Saves the image data list of images selected in the
Checked images pane in CSV format.

Print The [Print] dialog appears with various print settings.
Rotate Rotates the selected image 90° left or right. (p.34)
Sort by Sets the order of files or folders displayed in the

Checked images pane.
Thumbnails Displays the checked images with thumbnails.




Item Description

Details Displays the checked images in a list.”

Uncheck Selected Removes the check mark from an image selected in the

Image™ Checked images pane. This cancels the registration of
the image in the Checked images pane.

Uncheck All Removes check marks from all images in an active

check mark group. This cancels the registration of the
image in the Checked images pane.

Move to Folder Moves the image selected in the Checked images pane
to another folder.

Copy to Folder Copies the image selected in the Checked images pane
to another folder.

Extract JPEG Extracts the JPEG data for browsing from a PEF file or

DNG file (shot with IC7T0D/IK20D/IKK 200D/
IC-m/IC2000) selected in the Checked images
pane and saves it as a separate file.

Save as DNG Converts a PEF file selected in the Checked images
pane into a DNG file.

*1: This can only be selected from the right-click menu after selecting an image.
*2: When [Details] is selected, the checked images are sorted by folder and
displayed in a list.

Rotating Images in the Thumbnail Pane or Checked Images Pane

’ Select an image in the Thumbnail pane or Checked images
pane.

2 Select [Rotate] from the [Tool] menu.

Select [Rotate (90° Left)] or [Rotate (90° Right)] to rotate the image and
save it as the same file or as a new file.

Select [Rotate Display (90° Left)] or [Rotate Display (90° Right)] to rotate
the image in the Browser screen (Thumbnail pane, Checked images
pane or Preview pane) or Main image view window. [Rotate Display (90°
Left)] and [Rotate Display (90° Right)] are available when [Yes] is
selected for [Use Image Orientation Information] on the [Browser] tab of
the [Options] dialog. This is not available for images that do not have
orientation information.)

Alternatively, select [Rotate] on the toolbar, or from the menu displayed
after right-clicking the thumbnail in the Thumbnail pane or the Checked
images pane.



Main Image View Window

Menu bar Tool bar
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Image data pane Image view area

® Menu bar

This executes functions or sets various settings of the Main image view
window.

[File] menu

View Browser This shows the file browsing screen.

Open This opens the [Open] dialog to select the file to open.
If a check mark is next to [Open in new window], a
new Main image view window opens and the
selected image appears when a file is selected and
[Open] is clicked. (p.31)

Save As This saves the image being viewed in JPEG, TIFF (8-
bit or 16-bit), BMP, PNG or PICT format. (p.45)

Page Setup This sets the page setup information for printing the
selected image. (p.61)

Print This prints the current image. (p.57)

Properties Image file data appear. (p.41)

Close Closes the Main image view window.

Close All Closes all Main image view windows.




[View] menu

Tool Bar
Image Data
Previous Image

Next Image

Synchronous Display

Slideshow
Fit to Window
Enlarge

Reduce

Life size
Rotate View (90° Left)
Rotate View (90° Right)

Arrange Windows

This shows or hides the Tool bar.
This shows or hides the Image data pane.

This displays the previous image when multiple
images are displayed in the Main image view window
or when a folder contains multiple images. This button
cannot be selected if there are no images to view.
This displays the next image when multiple images
are displayed in the Main image view window or
when a folder contains multiple images. This button
cannot be selected if there are no images to view.
This sets whether to synchronize operations with
other Main image view windows.

Selected or checked images appear in order. (p.54)
This fits the image to the window size. (p.40)

This doubles the view magnification of the image
appearing in the image view area.

The maximum view magnification is 4 times. (p.40)
This halves the view magnification of the image
appearing in the image view area.

The minimum view magnification is 1/16. (p.40)
This sets the view magnification of the image
appearing in the image view area to life size. (p.40)
This rotates the image 90° left. This does not affect
the image file.

This rotates the image 90° right. This does not affect
the image file.

This arranges multiple Main image view windows.

[Tool] menu
Undo This undoes the previous file operation.
Crop This cuts a specified area of an image and deletes

Auto Image Fix
Rotate

PENTAX PHOTO
Laboratory

Options

unnecessary portions.

This automatically adjusts the brightness, contrast
and color tone. Select [Strong] or [Slight].

This rotates the image 90° left or right. (p.43)

This starts PENTAX PHOTO Laboratory 3. RAW

image files displayed in the Main image view window
can be opened in PENTAX PHOTO Laboratory 3.

(p.70)
This sets various settings for PENTAX PHOTO
Browser 3. (p.64)




[Help] menu

Help Topics This shows PENTAX PHOTO Browser 3 help
contents. (For Macintosh, select [PENTAX PHOTO
Browser Help].)

Index This shows PENTAX PHOTO Browser 3 help index
search. (This command is not available for
Macintosh.)

What's This? This shows pop-up tips when an icon or command

button is clicked.
About PENTAX PHOTO  This shows PENTAX PHOTO Browser 3 version

Browser information. (For Macintosh, select [About PENTAX
PHOTO Browser] on the [PENTAX PHOTO Browser]
menu.)

® Tool bar

Frequently used functions are provided as Tool bar buttons. You can
execute these functions easily from the Tool bar.

Remove the check mark next to [Tool Bar] on the [View] menu to hide the
Tool bar.

Number Icon (button) Content

1 This displays the Browser screen.

]
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iew Browser

This opens the [Open] dialog to select the file to
open. If a check mark is next to [Open in new
window], a new Main image view window opens
and the selected image appears when a file is
selected and [Open] is clicked.

s

This saves the image being viewed in JPEG, TIFF
(8-bit or 16-bit), BMP, PNG or PICT format. (p.45)
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Number Icon (button) Content
4 This prints the current image. (p.57)
Print
5 This shows selected file properties. (p.41)
Properties
6 This displays the previous image when multiple
images are displayed in the Main image view window
Previous Image or when a folder contains multiple images. This button
cannot be selected if there are no images to view.
7 This displays the next image when multiple images
are displayed in the Main image view window or
Next Image when a folder contains multiple images. This button
cannot be selected if there are no images to view.
8 Sets whether to synchronize operations with
other Main image view windows.
Synchronous Display
9 = Selected or checked images appear in order.
i (p.54)
Slideshow
10 This fits the image to the window size. (p.40)
Fit to Window
11 This halves the view magnification of the image
appearing in the image view area.
Reduce The minimum view magnification is 1/16. (p.40)
12 This doubles the view magnification of the image
appearing in the image view area.
Enlarge The maximum view magpnification is 4 times. (p.40)
13 This sets the view magnification of the image
appearing in the image view area to life size.
Life size (p-40)
14 The current view magnification appears. You can
|1 584 8 :l' also set the view magnification by selecting it from
Zoom the pull-down list, or by directly inputting the
magnification. (p.40)
15 This rotates the image appearing in the image
view area 90° to the left (counterclockwise).
Rotate View (p42)

(90° Left)




Number Icon (button) Content

16 This rotates the image appearing in the image
view area 90° to the right (clockwise). (p.42)
Rotate View
(90° Right)

17 This undoes the previous file operation.
Undo

18 This cuts a specified area of an image and
@ deletes unnecessary portions.
Crop

19 =y Click [ and select 1] or £ to automatically

|:|§' adjust the brightness, contrast and color tone.

Select [Strong] or [Slight].

20 This rotates the image 90° left or right. (p.43)

Rotate

21 — This starts PENTAX PHOTO Laboratory 3.

3 Specify the applicable image files within PENTAX

PENTAX PHOTO PHOTO Browser window. (p.70)
Laboratory

22 The PENTAX PHOTO Browser 3 setup screen
appears. This sets various settings for PENTAX
Options PHOTO Browser 3. (p.64)

23 ? This shows PENTAX PHOTO Browser 3 help
contents.

Help Topics

® Image view area

The image selected in the Thumbnail pane or Checked images pane of
PENTAX PHOTO Browser window appears.

e Image data pane

The image data appear for the image appearing in the image view area.
(p-20)

Place the cursor over a cell dividing line at the top of the pane and drag it
to resize the cell. (For Macintosh, drag at the applicable position to resize
the cell.)

@



You can set whether to show or hide the Tool bar and Image data pane in
the Main image view window.

Hiding the Tool Bar and Image Data Pane

’ Select [Tool Bar] or [Image Data] from the [View] menu in
the Main image view window and uncheck the item.

The Tool bar or Image data pane is hidden.

Settingsiss\My Documents\My Pictures\100PENTXVMGPOO25.PEF 5179

L=~ To display the Tool bar or Image data pane, select [Tool Bar] or [Image Data]

= from the [View] menu in the Main image view window and check the item.

Changing the View Magnification

You can change the image view magnification of the image appearing in
the image view area.

’ Select [Fit to Window], [Enlarge], [Reduce] or [Life size]
from the [View] menu in the Main image view window.
Alternatively, click the [=/, [& , [ or [=] icon on the Tool
bar.

The image view magnification can be adjusted from 1/16 to 4 times.



Enlarged view

You can also enlarge or reduce the view by directly inputting the numerical value
of the magnification in the View Magnification box [+ on the Tool bar.

1emo

Displaying Image Properties

You can display file data for the image file appearing in the Main image
view window. (p.53)
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Synchronizing Multiple Main Image View Windows

Synchronizes up to four Main image view windows. Synchronizes zoom,
position and frame advance operations.

1

}

memo

Select [Synchronous Display] from the [View] menu in the
Main image view windows.

Alternatively, click the [Synchronous Display] icon on the
Tool bar or select [Synchronous Display] on the menu
after right-clicking the Image view area.

The zoom, position and frame advance operations for the windows with
[Synchronous Display] selected are synchronized.

* When multiple Main image view windows are synchronized, the position of
an individual image can be changed by dragging that image while pressing
the Alt key. (For Macintosh, press the option key.)

« If you do not want the same image displayed in multiple Main image view
windows at the same time during frame advance with the Main image view
windows synchronized, use the settings on the [Options] dialog.

Rotating the Image View

Rotates the image view 90° left or right.

1

Select [Rotate View (90° Left)] or [Rotate View (90° Right)]
from the [View] menu in the Main image view window.
Alternatively, click the & or [ ¥ icon on the Tool bar.

The image appears rotated.
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m To save the rotated image, use [Rotate] on the [Tool] menu. (p.43)
A4

Saving a Rotated Image

Data of the displayed image are rotated 90° left or right and saved.
Rotation of the image may take time depending on the size of the image.
A warning message appears when closing the Main image view window
without saving the image or when clicking [<] [>].

’ Select [Rotate (90° Left)] or [Rotate (90° Right)] from
[Rotate] on the [Tool] menu in the Main image view
window.

14/ PENTX PHOTO Laboratary

1 optons

Alternatively, select [Rotate (90° Left)] or [Rotate (90° Right)] from the
Tool bar. (p.39)

2 Specify [Save in], [File name] and [Save as type], and then
click [Save].

The image is rotated and saved.

L=~ * When performing lossless rotation of an unprocessed JPEG image, the
~ [Rotate] dialog opens before the rotated image appears.
» The [Rotate] dialog does not appear for RAW files and processed JPEG
images. To save rotated images, select [Save as] from the [File] menu in the

Main image view window or click the icon on the Tool bar.



Cropping an Image

You can cut (crop) portions of an image displayed in the Main image view

window.

’ Select [Crop] from the [Tool] menu in the Main image view

window.

Alternatively, click the @ icon on the Tool bar.

The [Crop] dialog appears.

2 Set the cropping area.

Item Description
Cropping Aspect Ratio Maintain original aspect ratio:
Maintains aspect ratio of
original image.
Specify paper size : Uses paper size setting.
Specify aspect ratio : Sets desired aspect ratio.
Do not specify aspect ratio:
Does not set condition for
aspect ratio of cropping area.
Cropping Area Center™’! : Centers cropping area in
middle of original image.
Top Left™ : Sets cropping area based on

Bottom Right !
Top left coordinates :

Cropping Area

top left coordinates.

: Sets cropping area based on

bottom right coordinates.
Sets top left coordinates of
cropping area.

: Sets size of cropping area.

Bottom right coordinates:

Original size

Sets bottom right coordinates
of cropping area.

: Displays number of pixels of

original image.

*1: The cropping area is set by specifying the values, not by dragging the mouse.
Click [Reset] to return the set values to their initial settings.

J  Click [OK].



Saving an Image

You can save the displayed image using any of the following file formats.
RAW files can be saved with any of these formats to view the image with

image processing software.

JPEG : JPEG image with image data

TIFF (8-bit) . TIFF image with image data

TIFF (16-bit)  : High quality TIFF image with image data
BITMAP : BMP image without image data

PNG : PNG image without image data

PICT : PICT image without image data

’ Select [Save as] from the [File] menu in the Main image
view window or click the icon on the Tool bar.

The [Save as] dialog appears.

If the RAW file is viewed in Simple display or is reduced, a message
appears asking if you wish to return the image to full size. If [No] is
selected, the image is saved as it is displayed. The quality is reduced

compared to that of an image processed to full size.

Specify [Save in], [File name] and [Save as type], and then

click [Save].
Save As @
Savein | (3 10OPENTX ¥ O & £e [
IMGP2427 . PG IMGP37D3:ng IMGP4023, PG
File name: | flawwer | [ save ]
Save as bype: iJPEG vi Cancel

The image is saved.




Managing Image Files and Folders

Extracting a Full-size JPEG File from a RAW File

L= A preview JPEG file can only be extracted from PEF and DNG files shot with
K10D/KK20D/IC200D/IC-m!I€2000 .

’ Select an image for JPEG extraction in the Thumbnail
pane or Checked images pane of PENTAX PHOTO
Browser window.

2 Select [Extract JPEG] from the [Tool] menu.
Alternatively, right-click the image for JPEG extraction
and select [Extract JPEG].

‘) 3 Specify the save destination and file name.

L~ + To save the file with the file name of the original file, select [Use original file
name]. For example, if the original file name is “IMGP0001.pef”, the file name
of the extracted JPEG file will be “lMGP0001.jpg’”.

To save the file with a different file name, select [Rename]. In this case,
specify [Base file name] (file name prefix), [Number of digits] (number of
digits for number following the base file name) and [Start number] (number
following the base file name). When using [Extract JPEG] for multiple
images, the file name assigned to each image consists of the [Base file
name] and [Start number] in incremental order.

When using Windows, the options [Use original file name] and [Rename] are
available only when using [Extract JPEG] for multiple images.

Converting a PEF File to a DNG File

1~ DNG (Digital Negative) is a general-purpose, publicly-available RAW file
format designed by Adobe Systems.

’ Select a PEF file to convert to a DNG RAW file in the
Thumbnail pane or Checked images pane of PENTAX
PHOTO Browser window.



J

L

memo,

Moving/Copying Image Files

!
2

Select [Save as DNG] from the [Tool] menu.
Alternatively, right-click the PENTAX RAW image to be
converted to a DNG RAW file and select [Save as DNG].

Specify the save destination and file name.

« To save the file with the file name of the original file, select [Use original file
name]. For example, if the original file name is “IMGP0001.pef”, the file name
of the converted DNG file will be “IMGP0001.dng”.

To save the file with a different file name, select [Rename]. In this case,
specify [Base file name] (file name prefix), [Number of digits] (number of
digits for number following the base file name) and [Start number] (number
following the base file name). When using [Save as DNG] for multiple
images, the file name assigned to each image consists of the [Base file
name] and [Start number] in incremental order.

When using Windows, the options [Use original file name] and [Rename] are
available only when using [Save as DNG] for multiple images.

In the Thumbnail pane of the PENTAX PHOTO Browser
window, select the thumbnail image to move or copy.

Select [Cut] or [Copy] from the [Edit] menu.
Alternatively, click the = or [T} icon on the Tool bar.

=] PENTAX PHOTO Browser,
File B8 view Tool Help
LT E s ©-

inge'ss\My D ocumentstMy Pictures\1 DOPENT:

b+

G| 7 Delete Del

Move to Folder
Copy to Folder

Check Selected Image. 4

Uncheck Al 4

IMGP1E20PEF IMGP1E21 PEF
1/34/200% HA200K
10:4514 AM 11:4310 AW

Select All Chrl+is
Inwert Selection




3 Specify the destination folder for moving or copying in the
Folder tree pane.

4 Select [Paste] from the [Edit] menu.
Alternatively, click the [ icon on the Tool bar.

=] PENTAX PHOTO Browser,
File 2 view Tool Help

4 F -
@zf,’s cut il %3 D @ @ & O

A [y Copy Ctrl+€  jngshesiMy Documents\My Pictures

x

J

o checkSelected Image

Uncheck All 4 100PENTX

The image file is moved or copied to the specified folder.

_ @

=] PENTAX PHOTO Browser,

File Edit ¥iew Tool Help

Q- @9 d & -

Addiess [ C\Documents and SetingshssiMy Documents\Hy Pictures

(&} Desktop
[=1{} My Documents
A my usic
a S My Fictures ]
) 100PENTX
(= 1§ My Computer
A 3% Floppy (A:) =
< Local Disk (C:) ‘
< Local Disk (D:) 100PENTX IMGP1630PEF
s CDDrive (1) Wéﬁgﬁ%ﬂ
<o Removable Disk (Fi) i
- Contral Parel
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L=~ * You can also move an image by dragging and dropping a thumbnail image
to the destination folder.

To copy, hold down the Ctrl key while you drag and drop the file. (For
Macintosh, hold down the option key while you drag and drop the file.)
Use the same procedure to move or copy a folder. In the Folder tree pane,
specify the folder to move or copy. The specified folder is moved or copied
into the destination folder.



Deleting Image Files/Folders

1

In the Thumbnail pane of the PENTAX PHOTO Browser
window, select the file or folder to delete.

Alternatively, select the folder to delete in the Folder tree
pane.

Select [Delete] from the [Edit] menu.
Alternatively, click the [ icon on the Tool bar.

=] PENTAX PHOTO Browser,
File N2 view Tool Help

@gizsn culz @%}5@ m @' EIE Sl=h

[<%3

2 T copy Curl+C  jngeesiMy Documents\My Ficturest100FENT:
] Paste Chrl+y -

@ gl o=t el

E]
Mave to Folder
Copy to Folder

= Check Selected Image~ »

; ]
tncheck Al ' IMGP1EI0PEF IMGP1531 PEF
R4/200% RERZ00K

Select Al Curb+is 104574 41 11:43 10 41

Invert Selection

A delete confirmation screen appears.

Click [Yes].

The file or folder is deleted.
When a folder is deleted, all files in the folder are also deleted.

Changing File/Folder Names

1

In the Thumbnail pane of the PENTAX PHOTO Browser
window, select the file or folder to be renamed.
Alternatively, select the folder to be renamed in the Folder
tree pane.



Z Select [Rename] from the [File] menu.

Alternatively, directly click the file or folder name in the
Thumbnail pane or Folder tree pane.

The file or folder name is ready to be changed.

=] PENTAX PHOTO Browser,

Fle Edt view Tool Help

<} 98+LITE ® ©
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x

(&} Desktop
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' 100PENTX
=14 My Computer
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Local Disk (1)

Local Disk (09) IWGP1E30FEF G
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Removable Disk (F:) MG 114310 44
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3 Input the file or folder name.

The image file or folder is renamed.

Renaming All File Names

1

In the Thumbnail pane of the PENTAX PHOTO Browser
window, select the thumbnail images to be renamed.
Select [Select All] from the [Edit] menu to select all images in the
Thumbnail pane. However, files not supported by PENTAX PHOTO

Browser 3 and folders cannot be renamed. Images from more than one
folder cannot be selected.

Select [Rename All] from the [File] menu.
Alternatively, click the [ icon on the Tool bar.
The [Rename All] dialog appears.

Rename AlL.. ]
Base file name IMGFP Mumber of digits
] Put base file name last Start number oo &

| ——




3 Confirm the content, and input information as needed.

ltem

Description

Base file name

Specify name to add to file names. “IMGP” is added by
default.

Number of digits

Specify the number of digits to add to file names. 1 to
5 digits can be specified. 4 digits are specified by
default (example: IMGP1234.pef). When files exist in
the folder with the specified base file name, the
number of digits increases if the maximum number of
files is exceeded.

Put base file name last

When this option is checked, the file name specified for
[Base file name] comes after sequential file numbering
(example: 0123IMGP.pef). Base file name is added to
the beginning by default.

Start number

Sets the start number. When files exist in the folder
with the same specified base file name, the numbering
automatically starts from the number next to the
highest number of the existing file. If there is no file with
the specified base file name, numbering starts at 1.

4 ciick [OK].

All files are renamed to the specified name.

Creating a New Folder

’ In the Folder tree pane of the PENTAX PHOTO Browser
window, select the folder to create a new folder in.
Alternatively, select the Thumbnail pane.

2 Select [Create New Folder] from the [File] menu.
A new folder is created under the specified folder or in the Thumbnail

pane.

@



» When saving image data from the Thumbnail pane, the image files in the
current folder displayed in the pane can be saved (selectable).

* When saving image data from the Checked images pane, the images in
the active tab displayed in the pane can be saved. You can save the
image data from multiple folders into one CSV format file.

Saving a List of Image Data

In both cases, you can save only image data for the selected files.

’ Select [Save Image Data List] from the [Tool] menu in the
PENTAX PHOTO Browser window or click the icon on
the Tool bar.

The [Save Image Data List] dialog appears.

Save Image Data List.... (23]
Savein | [} Mp Documents e Nz B= =
‘) ) my Music
(2] My Fictures
Flerame: ||
Save astype: | Infomation List [ C5V) v

2 Specify the file name and save destination, and then click
[Save].

The image data are saved in CSV format.



Displaying Properties of Image Files/Folders

L The contents of the [Properties] dialog depends on the version of the operating

memo,

system currently running. Refer to Help in the operating system for details on
the [Properties] dialog settings.

In the Thumbnail pane of the PENTAX PHOTO Browser
window, select the thumbnail image for which properties
are to be shown.

Alternatively, in the Folder tree pane, select the folder for
which properties are to be shown.

Select [Properties] from the [File] menu.
The [XXX Properties] ([XXX Info] for Macintosh) dialog appears.

werouzs e propris——— () © O 0 IMGPI003.PEF info

¥ General:

=
i IMGPOOO3.PEF

Kind: PENTAXPHOTOBrowser PEF

Generdl [summary

ﬁ IMGPOOZS PEF

Type of file:  PENTAX Raw File

Opens with: ) PENTAX PHOTO Brow: Document

Size: 11.1 MB on disk (11,715,501 bytes)
Location:  C:\Documents and Settings|ss|Deskinp|FENTAY Where: Desktop:
Siee: 10,7 MB (11,317,894 bytes)

Created: Saturday, XXXX X, 200X
9:07 AM

Sizeondisk: 107 ME(11,321,344 bytes) Modified: Saturday, XXXX X, 200X

9:07 AM
Created:  Today, XX K, 2008, B:03:35 P
Modfied:  Today, X¥KX X, 200%, 8:12:58 P 3 Stitionery Pad
Accessed:  Today, X2 XX, 200%, B:12:58 P O Locked
Aeribuces:  [(Read-any,  [Hidden Advanced. ¥ GaRE Ciension
b Open with
B Preview.
B Ownership & Permissions:
B Comments:
For Windows For Macintosh

Confirm the content.

Click [OK].

The [Properties] dialog closes.
For Macintosh, click @ to close the [Info] dialog.



Continuous Image Playback in a Slideshow

This section explains how to set up and operate the slideshow.

1

Select an image or folder in the PENTAX PHOTO Browser
window.

Select [Slideshow] from the [View] menu or click the
icon on the Tool bar.

The Slideshow screen and Slideshow control panel open.

Slideshow screen

| | |
Slideshow control panel 1234567 8



Number Icon (button) Content

1 First Image Returns to the first image. When this is pressed
during a slideshow, the first image appears and
the slideshow pauses.

2 Rewind Rewinds slideshow. When this is pressed during
a slideshow, the next image appears and the
slideshow pauses.

3 Previous Image Slideshow is played in reverse order.

4 Pause Pauses slideshow.

5 Play Plays slideshow.

6 Fast Forward Fast-forwards slideshow. When fast-forwarding

during a slideshow, the next image appears and
the slideshow pauses.

7 Last Image Shows last image. You can use this during a
slideshow. The last image appears and the
slideshow pauses.

8 Stop Stops slideshow.

3 Press the [Play] button.

The slideshow starts.

Slideshow Settings

When viewing the slideshow, select between a single window and a dual
window. Additionally, view the slideshow in single full screen or dual full
screen mode (only if the computer is compatible with dual screen display).

Slideshow display settings and the image data displayed for each image
in the slideshow can be modified from the [Browser] tab in the [Options]
dialog. You can choose whether to display the image data during the
slideshow by checking the radio button [Yes] or [No] for [Display Image
Data During Slideshow]. (p.66)

The order in which frames are advanced during the slideshow is
determined by the current [Sort by] setting in the [View] menu.



56
Select from one of the four display patterns below.

Single window Single full screen
A A
]
£}
Dual window Dual full screen

|
|

B A B
|

I I T

e Image display order for dual window

When using dual window or dual full screen in PENTAX PHOTO Browser
3 slideshow, you can select the display method for images to be displayed
D on the primary and secondary monitors.

Advance in order

Pri
rl(n;?ry n =—>| n+t1 [=>| n+2 |=—>| n+3
Secondary
(B) n+1 |=—>| n+2 (=—>| n+3 [—>| n+4

Advance alternate

Pri
n(rx)ary n — n n+2 |=—| n+2

Sec?g;:lary n-1 n+1 [==—| n+1 n+3




Advance two frames

Pri(r;)ary n n+2 n+4 n+6
I 1 210 721
Sec;)g)dary n+1 n+3 n+5 n+7

Fix image to primary monitor

Primary

A) n —_— n —_— n —_— n
Secondary

®) n+1 [=>| n+2 (=) n+3 |—>| n+4

Printing an Image

When printing image files, select between [Print Index] and [Print photo].

Print Index : Prints thumbnails and their image data.

Print photo :  Prints a high-quality print of an image. You can print multiple images
on one page or print one large image on multiple pages using
partition printing.

Using Print Index

’ In the Thumbnail pane of the PENTAX PHOTO Browser
window, select the images to print.

2 Select [Print] from the [File] menu.
Alternatively, click the |53 icon on the Tool bar.

The [Print] dialog appears.

@



3 Select the [Print Index] tab.

Layou.
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XAX200X 44759 PM X/X/200X 4:51:45 PM. Infomation labels (m)
172
DI e
T TR [ rinocsennc ] ) T

@) 4 Make the layout and caption settings.

Item Description

Preview This displays a preview using the specified settings.
Layout Select from three layout patterns.

Number of images per From the list, specifies the number of images to print
page (W x H) on one page.

Print borders

Selects whether to display print borders for each
image.

Caption The caption settings are explained below. The
contents that appear depend on the selected layout.
Position Selects the image caption position from the list.
Contents Specifies the data that may be printed from the list.
Font Selects a font from the list. The default setting is the
standard system font.
Size Selects a font size from the list.
Information labels  Sets whether to print information label.
Printer The name of the printer to be used appears here.




L=~ The image size is calculated automatically from the margins, number of
images, and caption size.
« Click the [Page Setup] button to make the page settings. (p.61)
« Click the [Printer Settings] button to make the printer settings. (p.62)

J  click [OK].
Printing starts.

Using Print Photo

’ In the Thumbnail pane of the PENTAX PHOTO Browser
window, select the images to print.

2 Select [Print] from the [File] menu.
Alternatively, click the [5 icon on the Tool bar.

The [Print] dialog appears.

3 Select the [Print photo] tab.

T
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4 Make the layout and caption settings.

Item Description
Preview This displays a preview using the specified settings.
Layout Select from three layout patterns.

Layout 1 : Normal printing
Layout 2 : Layout printing
Layout 3 : Partition printing™
(printing one image on multiple pages)

Images per page

From the list, selects the number of images to print on
one page.

Multi-page printing

Selects the number of partitions per page from the list.

Allocating images

Selects processing options from the list when printing

area and image size differ.

No cropping : The image does not exceed the printing
area.

Cropping : The entire printing area is used and any
part exceeding the printing area is
deleted.

Position

Selects the position of the image in the printing area
from the list.

Space (Vertical)/
Space (Horizontal)

Sets the vertical and horizontal space in mm or inches.

Rotate to fit printing area

This setting uses the printing area most effectively.
Check this to allow the image to be rotated 90° as
needed to fit the printing area and then printed.

Fit to paper

Sets the printer to print using the maximum printing
area.

This can be set when [Layout 1] (Normal printing) or
[Layout 3] (Partition printing) is selected.

Print Shooting Date and

Sets the Shooting Date/Time print settings.

Time Position : Selects position to print Shooting Date/
Time.
Font : Selects a font from the list. The default
setting is the standard system font.
Print Time : Select from No (Default) or Yes
(HH:MM:SS, 24-hour format only).
Separator : Sets dividers in text.
Format : Sets date format.
Text color : Sets the font color.
Size : Selects a font size from the list.
Printer The name of the printer to be used appears here.

*1: When [Layout 1] (Normal printing) or [Layout 3] (Partition printing) is selected,
the [Fit to paper] checkbox is displayed. Check [Fit to paper] to ignore margin
settings and print images to the maximum print area of the printer.



L=~ The image size is calculated automatically from the margins, spacing, and
number of images.

» The printing orientation of the date/time depends on the image data (for
Windows only). The printing position is in a relative position to the image
data.

« Click the [Page Setup] button to select the page settings. (p.61)

« Click the [Printer Settings] button to select the printer settings. (p.62)

J  click [OK].
Printing starts.

Using Page Setup

Use Page Setup to set printing options such as margins, headers/footers,
and number of copies.

’ Select [Page Setup] from the [File] menu in the PENTAX
PHOTO Browser window.
Alternatively, click [Page Setup] on the [Print] dialog.

The [Page Setup] dialog appears.

Margine

Left < mm Right 5% mm Humber of copies
Upper 22| mm Lower %)% mm 18
Header 10)3] mm Footer 10/% | mm
Header
Pasition Do Nat Print v Font
Tert
Size
Footer
Position Do Mat Print v Font
Text

Size




2 Make the settings.

Item Description

Margins Left, Right, The default setting is 25 mm (1 inch) for paper larger
Upper, than A4, and 10 mm (0.4 inch) for smaller.
Lower
Header/ The default setting is 15 mm (0.6 inch) from the top and
Footer bottom edges.

Number of copies

Specifies the number of copies to print.

Header/ Position
Footer

Sets header/footer position. Select from Do Not Print
(Default), Align left, Align center, and Align right.

Font Selects a font from the list. The default setting is the
standard system font.

Text Enter text to print for the header/footer.

Insert Page When this is clicked, [# Page number] is inserted at the

Number cursor location in the Text field.

Insert No. of When this is clicked, [# Number of pages] is inserted at

Pages the cursor location in the Text field.

Size Selects a font size from the list. The default setting is
10 point.

J Click [OK].

The page setup information is set.

Using Printer Settings

Check the printer settings and change the settings as needed.
Refer to the printer user's manual for details on printer settings.

I~  This section describes the printer settings for Windows. For Macintosh, the
printer setting screen is dependent on the OS.



’ Click [Printer Settings] on the [Print] or [Page Setup]
dialog.

The [Print Setup] dialog appears.

Print Setup

Frinter

Mame:

Status: Feady

Tupe: EES RS
Wihhere:  XXRNKRNKK
Comrment:

Faper Orientation

Size: | Ad - | ) Paortrait

Source: |[I] w | O Landscape

2 Make the settings.

Item Description

Printer Selects the printer to use from the [Name] list.
Click [Network] to select a printer on the network.
Click [Properties] to make advanced printer settings.

Paper Size Selects paper size.
Source Selects paper feeding method.
Orientation Sets printing direction. Select [Portrait] or [Landscape].

J  Click [OK].

The printer setup information is set.



Changing the PENTAX PHOTO Browser 3
Settings

Here, you can set the PENTAX PHOTO Browser 3 settings, such as the
program launch or exit settings, the initial image view size, thumbnail
caption viewing, and RAW file view format.

’ Select [Options] from the [Tool] menu in the PENTAX
PHOTO Browser window.
Alternatively, click the ¥ icon on the Tool bar.

When the [Options] dialog appears, select the tab with the setting you
want to change.

Options E]ES)
Program Launch/Exit | Browser | Main Image Window | Other

Folder at Startup

‘) @ Las!folder used
(O Desktop

© Always use this folder

Status at Startup

@ Status at last exit

O Defauit

Show Splash Screen at Startup

@ s O No

On Exit

O Esit PENTAX PHOTO Browses oriy ® Exlt PENTAX PHOTO Labaratory at same:




2 After making your selections, click [OK].

The options are set and the [Options] dialog closes.
Click [Reset] to return all options to default settings.

m When [Reset] is clicked, all tab settings including the settings of the currently
open tab are returned to default settings.

[Program Launch/Exit] tab settings
Change the following settings for PENTAX PHOTO Browser 3 in the
[Program Launch/Exit] tab.

Item Description

Folder at Startup From the following, select the folder to open when
starting the program.
Last folder used:
This opens the folder that was last used in
PENTAX PHOTO Browser 3.
Desktop: This opens the desktop.
Always use this folder: (,
Click [Browse] to specify a folder.
Status at Startup Sets PENTAX PHOTO Browser 3 status at startup.
Status at last exit:
When the next session of PENTAX PHOTO
Browser 3 is started, the settings from the
previous session are used.
Default : The default screen appears.

Show Splash Screen at  Sets splash screen when PENTAX PHOTO Browser 3

Startup starts.
Yes : Splash screen is shown.
No : Splash screen is not shown.

On Exit Sets operation when exiting PENTAX PHOTO
Browser 3.

Exit PENTAX PHOTO Browser only:
Exits PENTAX PHOTO Browser 3 only even
if PENTAX PHOTO Laboratory 3 is also
open.

Exit PENTAX PHOTO Laboratory at same time:
Exits PENTAX PHOTO Laboratory 3 at the
same time as PENTAX PHOTO Browser 3
without displaying a confirmation message.




[Browser] tab settings
Sets the Browser screen display and slideshow settings in the [Browser]

tab.

ltem

Description

Thumbnail Date/Time

Sets the thumbnail date and time displayed in the
Thumbnail pane and Checked images pane.
Date/Time file was last modified:
Displays the date and time the file was last modified
(after the shooting date).
Date Exif information modified (Shooting date):
Displays the date and time the file was created
(shooting date).

Use Image
Orientation
Information

Sets whether to use information indicating image
orientation in the image file on the Browser screen and
Main image view window display.

Yes: Uses image orientation information.

No : Does not use image orientation information. When
[No] is selected, the thumbnail display does not
change even if [Rotate Display (90° Left)] or [Rotate
Display (90° Right)] is selected from [Rotate].

Display Orientation of
Images

Sets whether to display an icon indicating the image

display orientation on the Browser screen and Main image

view window.

Yes : Image display orientation is indicated with an icon.

No : Image display orientation is not indicated with an
icon.

Indicate Changes in
Image Data During
Frame Advance

Sets whether to indicate changes inimage data in red from

one file to the next during frame advance in the Main

image view window.

Yes: Changes in image data from one file to the next are
indicated in red.

No : Changes in image data from one file to the next are
not indicated in red.

Color Coding of
Checked Image
Thumbnail Border

Sets the color of the thumbnail border in the Checked
images pane according to the image file location (path).
Select from seven colors.

Slideshow Settings

Sets the pattern when viewing slideshows.
Single window:
View slideshow in a single window.
Dual window:
View slideshow in two windows (primary and
secondary).
Single full screen:
View slideshow full-screen on a single monitor.
Dual full screen:
View slideshow full-screen on two monitors.




Item Description
Frame Advance Sets the refresh method when viewing two images
During Dual View simultaneously (p.56).

Advance in order:
Frames advance in order. The secondary window
shows one image ahead of the primary window.

Advance alternate:
At each frame advance interval, images are shown
alternately on the primary and secondary windows.
With the first image starting at zero, even number
images are shown on the primary window and odd
number images are shown on the secondary
window.

Advance two frames:
Frames advance in twos.

Fix image to primary monitor:
The primary window shows a fixed image. The
secondary window shows images, which advance in

order.
Interval Sets interval for frame advance during slideshow.
Second(s):
Sets interval (in seconds) for frame advance.
Loop view Sets the repeat view setting. (,

No : When all of the images have been shown, the
slideshow ends.
Yes: The slideshow repeats until ended.

Display Image Data  Sets whether to display image data during slideshow. Also
During Slideshow selects information to display.

Yes: Displays image data during slideshow.

No : Does not display image data during slideshow.

[Main Image Window] tab settings
Changes the Main image view window settings in the [Main Image
Window] tab.

Item Description
Image Data Sets the height of the Image data pane that appears when
Pane Height the Main image view window opens.

Last size specified:
Sets Image data pane height to be the same as the
previous height when the Main image view window
opens.

Auto : The height is automatically adjusted.

Fixed: The number of lines can be specified.




Item Description
Window Size for Sets the window size of the Main image view window.
Main Image Last size specified:

Opens the Main image view window to the last
window size specified.

Default : Opens the window to the default size.

Set size : Specifies the size of the Main image view
window in pixels.

Display File Path in
Title Bar

Sets whether to display the file path in the title bar of the
Main image view window.

Yes : Displays the file path in the title bar.

No : Does not display the file path in the title bar.

Display Number of
Images in Title Bar

Sets whether to display “Display order/Total number of
images” when displaying multiple images in one Main
image view window.

Yes : Displays the display order and total number of
images in the title bar.
No : Does not display the display order and total

number of images in the title bar.

Showing Multiple
Images

When multiple images are selected in the Thumbnail pane,
select the viewing method in the Main image view window.
Single window:
Images appear in one Main image view window.
Click the icon on the Main image view
window Tool bar to switch the image view.
Separate window:
Images appear in multiple Main image view

windows.
Main Image View for Sets view when opening a new RAW file.
RAW File Simple display:

The compressed image data in the RAW file
appear. The image data appear more quickly,
but there is quality loss due to the high
compression rate. Therefore, this function is not
recommended for checking image details.
Auto RAW display:
The actual RAW file appears. (Full Auto
Processing)
Size (Ratio):
Select the processing ratio for Auto RAW
display from [1:4], [1:2], or [Life size]. When
emphasizing speed, select [1:4]. When
emphasizing quality, select [Life size].

View Attributes to
Maintain

Selects view attributes to maintain during frame advance.
Multiple attributes may be selected.

Zoom : View magnification is maintained.

Position : Position is maintained.

Direction : Direction is maintained.




Item Description

Synchronous Display Sets whether to show all images for each synchronized
Frame Advance Main image view window when advancing frames during
synchronous display of multiple Main image view
windows.
In order : Shows all images.
Skip : Skips images displayed in other synchronous
display windows.

[Other] tab settings
Change the display alert and color management settings in the [Other] tab.

Item Description

Display Alerts Sets whether to display alerts.
Yes: Displays alerts. (The “In the future, do not show this
message.” check box is not checked for all alerts.)
No : Does not display alerts. (The “In the future, do not
show this message” check box is checked for all

alerts.)
Working Color Sets color management method during image display.
Management Normal Display:

Displays the image with the color management set
for the image.

Disable Color Management:
Color management is disabled.

Simulated wide gamut display:
Expressive range of Adobe RGB is compressed to
sRGB expressive range and displayed. As the sSRGB
gamut is narrower than the Adobe RGB gamut, color
reproduction is not completely accurate. However,
you can confirm colors in the Adobe RGB gamut that
cannot be expressed by the sRGB gamut.

Color Management  Sets profile to use when printing.
During Printing Use printer settings:
Uses printer settings for profile when printing.
Select color profile:
Selects profile to use when printing from the [Profile]
drop-down list.
Disable Color Management:
Disables color management and does not use a
profile when printing.

Units mm : Sets units of length displayed in dialogs to
millimeters (mm).
in. : Sets units of length displayed in dialogs to inches.




PENTAX PHOTO Laboratory 3

PENTAX PHOTO Laboratory 3 supports a number of image processing
functions for use with PEF and DNG files, including data conversion, color
adjustment, and image compensation. The processing of these files
enables images to be viewed on non PEF and DNG compatible
commercially-available image viewing and editing software.

This section describes opening and closing PENTAX PHOTO Laboratory
3 and viewing the PENTAX PHOTO Laboratory window, and explains its
functions.

You can only perform image processing operations for DNG files taken with PENTAX
digital cameras and DNG files converted with PENTAX PHOTO Browser 3.

Opening PENTAX PHOTO Laboratory 3

For Windows

’ Select the start menu on the desktop.

2 Select [All Programs] - [PENTAX
Digital Camera Utility] -[PENTAX
PHOTO Laboratory].

PENTAX PHOTO Laboratory 3 is
D opened, and the PENTAX PHOTO
Laboratory window appears.

® Closing PENTAX PHOTO Laboratory 3
Select [Exit] from the [File] menu on the PENTAX PHOTO Laboratory
window.

I~ PENTAX PHOTO Laboratory 3 can also be started from within PENTAX
" PHOTO Browser 3. (p.26)



For Macintosh

’ Double-click the [PENTAX Digital Camera Utility] folder in
[Applications] on the hard disk.

2 Double-click the [PENTAX i T s
PHOTO Laboratory] program 0 B &
i con- PENTAX PHOTO Browser |  PENTAX PHOTO Laboratory
PENTAX PHOTO Laboratory 3 is
opened, and the PENTAX PHOTO
s, 68,84 7

Laboratory window appears.

® Closing PENTAX PHOTO Laboratory 3
Select [Quit PENTAX PHOTO Laboratory] in [PENTAX PHOTO
Laboratory] on the desktop menu bar.

¥ PENTAX PHOTO Laboratory 3 can also be started from within PENTAX

memo,

PHOTO Browser 3. (p.26)




About the PENTAX PHOTO Laboratory Window

This section explains the PENTAX PHOTO Laboratory window layout,
names, and functions.

PENTAX PHOTO Laboratory 3 is made up of seven panels.

The control panels are independent and can be repositioned anywhere on
the screen. Select [Arrange Windows] from the [View] menu to align the
panels.

Six panels, not including the Main panel, can be hidden or shown.

Preview panel
Tone panel —|

Htegan

Bigriness ]

Main panel
Menu bar

315 ENTAX FHOTO Laboratory,

Tool bar

v
0
v ) Gian
0

E |

L White balance panel

— ”T Other settings panel

Noise reduction panel
+— Lens aberration correction panel

+ When the processing mode is set to [@ (Full Auto Processing), the White
Balance panel, Tone panel, Other Settings panel, Noise Reduction panel,
and Lens aberration correction panel are not displayed (p.76). In addition, the

and buttons in the Preview panel are not available.

* When a RAW file is not selected, the preview image does not appear. (p.77)

e



® Main panel

This executes functions or sets various settings of PENTAX PHOTO
Laboratory 3.

For Macintosh, the Main panel only contains the Tool bar. The Menu bar
appears at the top of the desktop.

® Preview panel

You can preview adjustments made for a selected RAW file in the panels.
You can also enlarge part of the RAW file.
View adjustments in real time or by clicking the [Refresh] button. (p.77)

® White balance panel

Selects white balance or sets color temperature. Adjust the image color
tone, such as when the image appears bluish or yellowish. (p.85)

® Tone panel

Displays tone curve and histogram information of displayed image. (p.86)
Adjusts the image tone using the tone curve.

® Other settings panel

Adjusts characteristics such as sensitivity, contrast, color depth, and
edges. (p.87)

® Noise reduction panel

Removes and reduces random noise and spurious color signals peculiar
to digital cameras (color moire). (p.88)

® Lens aberration correction panel

Corrects marginal lumination, distortion and lateral chromatic aberration
due to lens aberration. (p.88)

® Menu bar C,

This executes functions or sets various settings of PENTAX PHOTO
Laboratory 3.

[File] menu

Open This selects the image file for processing in PENTAX
PHOTO Laboratory 3. Only applies when the
software is started as standalone. This cannot be
used when PENTAX PHOTO Laboratory 3 is started
within the PENTAX PHOTO Browser window. (p.79)




[File] menu

Save

Recall Adjustment
Save Adjustment

Print
Exit

This performs RAW file data processing and saves it
with the specified format. The available save formats
are JPEG (5 compression rates), TIFF-8, and TIFF-
16. Use [Save Mode] on the [Tool] menu to specify
the save format. (p.90)

Use this function to load previously saved settings for
the various panels. (p.92)

Use this function to save the settings currently used
in the various panels. (p.91)

The [Print] dialog appears with various print settings.
This closes PENTAX PHOTO Laboratory 3.

(For Macintosh, select [Quit PENTAX PHOTO
Laboratory] on the [PENTAX PHOTO Laboratory]
menu.)

[View] menu

Full Auto Processing

Custom Processing

First Image
Previous Image
Next Image
Last Image
Refresh Preview
Preview

White Balance

Tone
Other Settings

Each RAW file is processed according to the camera
settings when the image was taken. All panels,
except the Preview panel, are hidden. (p.83)

This performs processing using the processing
condition settings specified by the user. The
processing conditions are set using the White balance
panel, Tone panel, Other settings panel, Lens
aberration correction panel, and Noise Reduction
panel. (p.84)

When multiple images are selected, the preview of
the first image in order of registration appears.
When multiple images are selected, the preview of
one image ahead in order of registration appears.
When multiple images are selected, the preview of
one image back in order of registration appears.
When multiple images are selected, the preview of
the last image in order of registration appears.
When real-time preview is not enabled, the preview is
refreshed using the current settings.

This shows or hides the Preview panel.

This shows or hides the White balance panel.

This shows or hides the Tone panel.

This shows or hides the Other settings panel.




[View] menu

Noise Reduction
Lens aberration correction

Arrange Windows

This shows or hides the Noise reduction panel.
This shows or hides the Lens aberration correction
panel.

This arranges the displayed panels to the default
positions.

[Tool] menu

Undo

Redo

Image Tone

Save Mode

Rotate

Crop/Resize

Options

When in Custom Processing mode, use this function
to cancel the previous operation. You can undo up to
five operations.

When in Custom Processing mode, use this function
to redo an operation that was cancelled with the
[Undo] button.

Select a type of photofinishing. In Custom Processing
mode, image tones appropriate for the subject or
shooting scene are available. This function is not
available in Full Auto Processing mode. (p.83)

This sets the quality when saving processed images.
Save images in JPEG format with one of five different
compression rates or in TIFF format with one of two
bit types. The default setting is JPEG (Highest
Quality).

Rotates the Preview panel view 90° left or right. The
rotated image is saved without changing the RAW
file.

The dialog for cropping and resizing the image
appears.

This sets various settings for PENTAX PHOTO
Laboratory 3. (p.99)

[Help] menu

@

Help Topics

Index

What's This?

About PENTAX PHOTO
Laboratory

This shows PENTAX PHOTO Laboratory 3 help
contents. (For Macintosh, select [PENTAX PHOTO
Laboratory Help].)

This shows PENTAX PHOTO Laboratory 3 help
index search. (This command is not available for
Macintosh.)

This shows pop-up tips.

This shows PENTAX PHOTO Laboratory 3 version
information. (For Macintosh, select [About PENTAX
PHOTO Laboratory] on the [PENTAX PHOTO
Laboratory] menu.)




Tool Bar

This executes functions or sets various settings of PENTAX PHOTO
Laboratory 3.
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Number Icon (button) Content

1 This selects the image file for processing in
PENTAX PHOTO Laboratory 3. Only applies
when the software is started as standalone. This
cannot be used when PENTAX PHOTO
Laboratory 3 is started within the PENTAX

PHOTO Browser window. (p.79)
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This performs RAW file processing and saves it
with the specified save mode and image size.
(p.90)

=

2]
Q
<
(0]

This appears when Full Auto Processing is set.
Performs processing using the processing
conditions set in the RAW file.

Click [~ to select [@ or [&] from the pull-down menu.

5
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uto Processing

This is displayed when Custom Processing is set.
+ This performs processing using the processing
condition settings specified by the user. The
processing conditions are set using the White
balance panel, Tone panel, Other settings panel,
Lens aberration correction panel and Noise
Reduction panel. (p.84)

5

o

ustom Processing

When in Custom Processing mode, this recalls a
saved adjustment file. (p.92)

S
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ecall Adjustment

This saves the processing conditions set in
Custom Processing mode as an adjustment file.

ave Adjustment (p.91)
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When in Custom Processing mode, use this
function to cancel the previous operation. You
can undo up to five operations.
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When in Custom Processing mode, use this
function to redo an operation that was cancelled
with the [Undo] button.
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Number Icon (button)

Content

8 This displays the current Image tone. Select an
T image tone appropriate for the subject or shooting
Image Tone scene by clicking [+ in Custom Processing mode.

9 This function is not available in Full Auto
Processing mode. (p.83)

9 FiE This displays the current Save mode. Click [ to
T select the save format for the processed image
Save Mode file. (p.90)

10 This rotates the Preview panel view 90° left or
right. RAW files are processed according to the
Rotate selected direction.

11 This is used to change the PENTAX PHOTO
Laboratory 3 settings. (p.99)
Options

12 ? This shows PENTAX PHOTO Laboratory 3 help
contents.
Help Topics

Preview Panel

This shows a preview of the RAW file.

Preview

IMGPOODT PEF




Number Icon (button) Content

1 Rotates the image based on the baseline or shifts
it in a vertical or horizontal direction.

o

Py

otate/Shift

Crops portions of an image and changes the
image output size.

N
A=

rop/Resize

When this is turned on, a red frame appears in the
preview area. The Enlarge area window appears
and the magnification can be selected.

w

Enlarge Area

4 Click this to refresh the preview using the current
@ settings when [Refresh Preview] becomes the
Refresh [Refresh] button on the Options settings of

PENTAX PHOTO Laboratory 3.

5 I Shows the file name of the image currently
displayed in the Preview panel. When multiple
images are selected, select the image to display
from the list.

6 When multiple images are selected, the preview
of the first image in order of registration appears.

7 When multiple images are selected, the preview
of one image ahead in order of registration
Previous Image appears.

8 When multiple images are selected, the preview
of one image back in order of registration
Next Image appears.

9 When multiple images are selected, the preview
DN of the last image in order of registration appears.




Selecting a RAW File to Process

Select a RAW file in the PENTAX PHOTO Browser window.

Select [PENTAX PHOTO Laboratory] on the [Tool] menu of
PENTAX PHOTO Browser 3 or click the ﬁ icon.

A RAW file appears in the Preview panel of the PENTAX PHOTO
Laboratory window.

| IMGPOODT.PEF

Select multiple image files to open multiple images at the same time.

Click the [i¥d, [<0], [>], or M| button on the Tool bar to preview the desired
image.




L=~ * To select multiple image files, hold down the Ctrl key and click on thumbnail
images in the Thumbnail pane or the Checked images pane (For Macintosh,
hold down the command key and click on image files). Selected thumbnail
images are indicated by a blue border.
When PENTAX PHOTO Laboratory 3 is launched with the Checked images
pane selected but no thumbnails in the active group specified (none of the
thumbnails are displayed with a blue border), all RAW images in the active
group will be opened in PENTAX PHOTO Laboratory 3.
When a file selected in PENTAX PHOTO Browser 3 is opened and edited
with PENTAX PHOTO Laboratory 3 and another file is selected in PENTAX
PHOTO Browser 3, the “The image has been modified. Do you want to save
changes?” dialog is displayed.
Click [Cancel] to retain changes made with PENTAX PHOTO Laboratory 3
and select another image in PENTAXPHOTO Browser 3.
Select the “In the future, do not show this message” checkbox and click
[Cancel]. The confirmation dialog will no longer be displayed. Changes made
in PENTAX PHOTO Laboratory 3 will be retained and operations in PENTAX
PHOTO Browser 3 will be enabled.
Select [No] in “Display Alerts” of the “Options” dialog in PENTAX PHOTO
Laboratory 3 and select [OK]. Then, select [Yes] in “Display Alerts” and click
[OK] to turn on the dialog again.

Opening a RAW File in PENTAX PHOTO Laboratory 3

’ Click the |77 icon in the PENTAX PHOTO Laboratory
window.

The [Open] dialog appears.

Open

Look jn: | (3 TOOPENT: v Q2 o

RAW W RAW
| l |
PENTAX

IMGPO0S. PEF IMGPOOZ1,PEF

v

Files of type: | PENTAS, R File [* PEF) o




2

Select RAW files to display and click the [Open] button.

Select images with holding down the Ctrl key (Windows) or command key
(Macintosh) in the [Open] dialog to open multiple files simultaneously.

A RAW file appears in the Preview panel of the PENTAX PHOTO
Laboratory window.

Rotate/Shift Settings

1

Click the icon in the PENTAX PHOTO Laboratory
window.

The Rotate/Shift panel appears.

Check the [Apply] check box and adjust the parameters to
rotate or shift the image.

When [Real time] is selected for [Refresh Preview] in the [Options]
dialog, the changes to the parameters are immediately applied to the
preview. When [Refresh button] is selected for [Refresh Preview], click
the [Refresh] button on the Preview panel or select [Refresh Preview] on
the [View] menu.

Item Description
Rotate Degrees : Adjusts the angle of rotation.

Baseline : Rotates the image until the line you
marked on the preview image is vertical
or horizontal.

Shift Vertical shift : Shifts the image vertically.

Horizontal shift : Shifts the image horizontally.

Lens angle of view : Necessary information for shifting the
image. This is accurately set based on
the image file information by default;
however, this can be changed to alter
the vertical-horizontal shift ratio.

Crop/Resize Settings

1

Select [Crop/Resize] from the [Tool] menu.
Alternatively, click the @ icon on the Preview panel.



2 Set the cropping area and image output size on the Crop/
Resize panel.

Click [Reset] to return the set values to their initial settings.

Item Description

Cropping Aspect  Maintain original aspect ratio:

Ratio Maintains aspect ratio of original image.
Specify paper size:

Uses paper size setting.
Specify aspect ratio:
Specifies desired aspect ratio.
Do not specify aspect ratio:
Does not set condition for aspect ratio of
cropping area.

Cropping Area Center : Centers cropping area in middle of original image.
Top Left: Sets cropping area based on top left coordinates.
Bottom Right : Sets cropping area based on bottom right

coordinates.
Top left coordinates:
Sets top left coordinates of cropping area.
Cropping size: Sets size of cropping area.
Bottom right coordinates:
Sets bottom right coordinates of cropping
area.
Original size : Displays number of pixels of original image.

Image Size Do not resize:
Select this to not change the image output size.
Specify image size:
Select this to specify the number of pixels (by width
and height) for the image output size. Enter the
number of horizontal and vertical pixels in [W] and
[H] for [Specify image size] on the right side.

Specify resolution:

D Select this to specify the resolution (in dpi) for the
image output size. Enter the resolution (dpi) and
horizontal and vertical size (in mm or inches) in
[Specify resolution] on the right side of [Specify
image size]. When [Specify paper size] is specified
in [Cropping Aspect Ratio] for [Crop/Resize], select
the paper size specified as the output size.




J  Click [OK].

The image is cropped.

The cropping area remains on the image in the preview panel, and the
icon is selected. After the image is processed, the cropping area is

saved with the specified pixels.

To cancel cropping, click the @ icon again to undo the cropping area.

Easily Modifying RAW Files

In Custom Processing mode, simple image processing suited to your
shooting intent is possible with selection of an Image tone with PENTAX
PHOTO Laboratory 3.

You can select from six Image tone options*1 available with [Custom
Image], a new feature on the /KK 20D/IK 200D, in addition to five
Picture modes ™ and nine Scene modes 3.

*1 [Bright], [Natural], [Portrait], [Landscape], [Vibrant], and [Monochrome]

*2 [Picture (Portrait)], [Picture (Landscape)], [Picture (Macro)], [Picture
(Moving Object)], and [Picture (Night Scene Portrait)]

*3 [Scene: Night Scene], [Scene: Surf & Snow], [Scene: Food], [Scene:
Sunset], [Scene: Kids], [Scene: Pet], [Scene: Candlelight], [Scene:
Museum], and [Scene: Text]

L

memo  When in Full Auto Processing mode, RAW files are processed using the Image

tone selected at the time of shooting. This setting cannot be changed in
PENTAX PHOTO Laboratory 3.




Setting RAW File Processing Conditions

Set individual processing conditions to create unique image modifications.

’ Select [Custom Processing] from the [View] menu, or click
~ on the |@[- icon on the Tool bar and then click
(Custom Processing) on the drop-down list.

The Main panel, Preview panel, White balance panel, Tone panel, Other
settings panel, Lens aberration correction panel, and Noise Reduction
panel appear.

5l

L=~ To close the White balance panel, Tone panel, Other settings panel, Lens
aberration correction panel, or Noise Reduction panel, select [Full Auto
Processing] from the [View] menu, or click | on the icon on the Tool bar
and then click (Full Auto Processing) on the drop-down list. The image is
processed using the Image tone set at the time of shooting, and the settings
cannot be changed in PENTAX PHOTO Laboratory 3.

* When multiple RAW files are selected, the same processing conditions are
applied to all selected files. Use the Queue list to set different processing
conditions for each file and to process all the files at once. (p.91, p.102)



Enter settings in each setting panel.

The settings are reflected in the Preview panel. Settings can be applied in

one of two methods, determined by the setting in the [Options] dialog. (p.99)

* Reflect the settings immediately in real time.

* Reflect the settings when clicking the icon on the Preview panel.

o Setting the White balance
White Balance 5]

‘hite Balance Settings @)
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Item

Description

White
Balance
Settings

Select from the following:
Camera setting:
Apply the white balance setting used on your camera.
Override:
Select the white balance to apply from [Daylight], [Shade],
[Cloudy], [Daylight fluorescent], [Neutral white fluorescent],
[Cool white fluorescent], [Tungsten lamp], or [Flash].
Gray point setting:
Select the point in the preview image to turn gray. Specify using
the pointer for the most appropriate white balance setting. Select
from [1 point], [3 points], or [5 points]. When shooting a gray card
to set the Gray point setting, a more accurate white balance may
be achieved. Click [Reset] to delete the selected gray points.
Set color temperature:
The white balance is set according to the color temperature
setting. Slide the bar to set the color temperature or select the
value from the list. Select from between 2500K to 10000K (in
Kelvin).

Fine tune

Use the slide bars to adjust the white balance of Amber and Blue,

and Magenta and Green to your liking. (Set up to seven steps for all
directions of colors.) Adjust White Balance mode (Camera setting,
each Override option, Gray point setting, Set color temperature) for
white balance settings for each image.




® Setting the Tone curve/Histogram

@
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Item

Description

Tone curve

Adjusts the tone curve to make precise adjustments to the
density and contrast. Change the tone curve using the
pointer. Move the curve up to brighten and move the
curve down to darken the image.

Click a point on the tone curve to fix the curve at that
point. A black dot appears. The black dot may be dragged
and moved. Right-click to erase the black dot. (For
Macintosh, hold down the control key while you click the
black dot.)

Histogram

Brightness shows the distribution of luminosity when
combining RGB, R (Red), G (Green) and B (Blue).

Show Bright Portions/
Show Dark Portions

When all [Show Bright Portions] check boxes are
selected, the bright portions of the image are shown in
flashing gray.

When all [Show Dark Portions] check boxes are selected,
the dark portions of the image are shown in flashing white.
You can check bright portions with the flashing
complementary color for each color, and the dark portions
with the flashing of each color.

Reset

Deletes the tone curve settings, and returns to a straight
line.

Highlight Adjustment

Adjusts the highlight areas. Place priority either on color
or brightness and on saturation or hue, and use the
[Highlight compensation] slider to compensate for bright
portions.




® Setting the Sensitivity/Saturation/Hue/Sharpness/Contrast/Filter
Effect/Toning/Shadow Compensation
Set these using the Other settings panel.

Other Settings

Sensitivity

Saturation

-4

Sharpness

4

[] Shadow Compensation

Item

Description

Sensitivity

Adjusts the sensitivity.
+ : The image becomes brighter.
— : The image becomes darker.

Saturation

Adjusts the strength of the colors.
+ : The colors become stronger.
— : The colors become weaker.

Hue

Adjusts the hue in four levels in the clockwise direction

and counterclockwise direction on the hue circle.

+ : Changes the hue in the clockwise direction on the hue
circle.

— : Changes the hue in the counterclockwise direction on
the hue circle.

Sharpness

Adjusts the sharpness of the edges.
+ : Image contour is enhanced.
— : Image contour is softened.

Contrast

Adjusts the contrast between light and shadow.
+ : Increases contrast between light and shadow.
— : Decreases contrast between light and shadow.

Filter Effect

Adjusts the shading resulting from the color differences in
an image processed in monochrome.

Select from [None], [Green], [Yellow], [Orange], [Red],
[Magenta], [Blue], [Cyan], and [Infrared Color].




Item Description

Toning Sets the color tone of an image processed in
monochrome to a cold tone with a bluish hue or a warm
tone with a brownish hue.

+ : Adjusts color to a warmer tone.
— : Adjusts color to a colder tone.

Shadow The gradation of shadow is compensated automatically.
Compensation

@ Setting the Noise Reduction
Set using the Noise reduction panel.

Noise Reducation

[l kit D
| P
[]Spurious color signal reducation i} E
| Resmmen AR TR
Item Description
Random noise Reduces random noise (especially electrical noise visible
reduction in dark areas).
Spurious color signal  Each pixel in a single-chip image sensor, such as a CCD
reduction or CMOS, represents red, green or blue, and when

photographing a subject adjacent to clear lines or fine
patterns, these pixels may appear to generate colors not
in the original image (spurious color signals). This
function reduces spurious color signals.

@ Setting the Lens Aberration Correction
Set using the Lens aberration correction panel.

Lens aberration correction

Marginal lumination compensation | Distortion Correction | Lateral Chiomatic Aberration € * 2

[ apply
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[Marginal lumination compensation] tab
Adjusts marginal lumination of the image.

Item Description

Lens angle of view Sets the viewing angle of the lens used when shooting.
Slide to the left to make the marginal illumination linear at
the center portion of the lens, and slide to the right to
correct the outer portions of the lens.

Compensation The slider sets the compensation level. Set the
compensation level between —50 and +120. Slide
towards — for darker and + for brighter compensation.

[Distortion Correction] tab
Corrects distortions (lens aberration that photographs straight lines as
curved lines).

Item Description

Correction balance The slider adjusts the distortion correction level between
the center and margins of the image. (Slide to the right to
widen the range.)

Compensation The slider sets the compensation level.

[Lateral Chromatic Aberration Correction] tab

Corrects lateral chromatic aberration in which there is a difference in the
image magnification and image size due to different color wavelengths at
the image margins.

Item Description
Red compensation The slider adjusts the magnification of red light.
Blue compensation The slider adjusts the magnification of blue light.




Saving Image Files

You can save the image files which have been Full Auto processed or
Custom processed. Specify the save format and image size when saving
image files. Save images in JPEG format with one of five different
compression rates, or in TIFF-8 or TIFF-16 format.

As the compression rate increases, the file size decreases, but the quality
also deteriorates.

’ Select [Save Mode] from the [Tool] menu, or click | on the
right of the % - icon to select the save format.

Select the quality and file format when saving RAW files.

For JPEG files, image data are compressed and saved. Select from
Highest Compression, High Compression, Medium Quality, High Quality,
and Highest Quality. Select High or Highest Compression to make the
file size smaller by lowering quality. Select High or Highest Quality to
maintain high quality by keeping the file size large.

Select TIFF-8 or TIFF-16 to avoid quality loss due to compression.
Although selecting TIFF-16 leads to a larger file size, quality loss is
minimized when modifying the file with other image editing software.

PENTAX PHOTO Laboratory
File Wiew Tool Help
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Z Select [Save] from the [File] menu or click the icon on
the Tool bar.

The [Save] dialog appears.

Savc... ]S
Saven: | 3 T00PENTAX ¥ o2 2|
b Eme
Save as ype: |JPEG (Highest Compression] v
L=~ When multiple images are selected, the [Save] dialog is not displayed. The

images will be saved, with their original file names, to the [Folder to Use]
specified in [Options] (p.99) (file extensions will be modified automatically
according to the specified file format).

3 Specify the file name and save destination, and then click
[Save].
The image file is saved.

L~  When [Use queue list] is set in [Options], adjustment is added as a job to the
[Image Processing Queue List] dialog for batch processing to be performed
later. (p.102)

Saving Image File Adjustment

All current adjustment combinations can be saved as a parameter file.
Saved adjustment can then be applied to other RAW files for processing.

’ Click [Save Adjustment] from the [File] menu on the Main
panel or click the [/ icon.



The [Save Adjustments] dialog appears.

Save Adjustments @@
Save jn: |2 T00PENTX ¥ o2 2|
Save as lype: | Adustment Fie [~INI] v

Z Specify the file name and save destination, and then click
[Save].

The current settings are saved as an adjustment setting file (*.ini).

Recalling Image File Adjustment

’ Display a RAW file in the Preview panel.

Click [Recall Adjustment] from the [File] menu on the Main
panel or click the [¢7] icon.

The [Open Adjustment File] dialog appears.

3 Select a folder and parameter file name, and then click

D [Open].

The settings saved in the parameter file are reflected in the parameters
of the RAW file.



Printing

You can print the currently displayed RAW file. Print image files using
[Print Bracketing] or [Enlarge image].

[Print] dialog

Set the print layout, captions, and other settings in the [Print] dialog.

® Opening the [Print]
dialog

Select [Print] on the [File]

menu to open the [Print]

dialog.

o [Print] dialog settings
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The [Print Bracketing] and [Enlarge image] setting tabs appear in the

[Print] dialog.




[Print Bracketing] tab

Print bracketing is a function that prints an image several times on one
page with automatically adjusted parameters within a set parameter
range, enabling you to view the printed results of different parameters at
the same time. Printing the image on your printer with this function is useful
for determining the optimal parameters for that image.

Print

Fiin Bracketing | Enlarge image

Displey Mode:

© Segment selection

X
Pint Layout
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OPiint preview
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Display Mode
Sets preview method.

Item

Description

Segment selection

Switches to window for selecting image area for print
bracketing.

Print preview

A preview of the print layout is displayed.




Print Layout

Sets print bracketing settings.

Item

Description

Segment
Specification

Selects image area setting method for print bracketing.

Select from the following three settings.

Segment original image:
Divides entire image into equal sections and
allocates bracketing variations for each section.
This is useful for reviewing the changes in set
parameters while previewing the entire image.

Repeat segment:
Cuts part of image and prints several repeating
tiles with different bracketing parameters. This is
useful for reviewing the optimal settings for the
most important area in the image. When this
setting is selected (and [Segment selection] is
selected for [Display Mode]), you can select the
area repeatedly printed in the preview.

Repeat small original:
Reduces entire image size and prints several
repeating tiles with different bracketing
parameters. This is useful for verifying the effects
of varying parameters on the entire image.

Segmentation

Sets segmentation method of print area. Select from the
following three settings.

Segment vertically:
Divides area vertically. Only one bracketing
parameter can be changed.

1 block : Divides area into multiple horizontal and vertical
sections. Two bracketing parameters can be
changed.

3 blocks: Divides area into multiple horizontal and vertical
sections fixed at three vertical positions. One
bracketing parameter can be changed, but prints
three areas of image.

Segments

Sets number of horizontal and vertical divisions. Selectable
value depends on selected segmentation method.

Bracketing 1

Selects bracketing parameter to be changed horizontally.
Choose from nine parameters: Sensitivity, Saturation, Hue,
Sharpness, Contrast, Filter Effect, Toning, Fine tune A-B
and Fine tune M-G. (The same parameter cannot be
selected for Bracketing 1 and Bracketing 2.)




Item

Description

Bracketing 1 steps

Selects variable step of bracketing parameter to be
changed horizontally. The range of the variable step
depends on the selected bracketing parameter.

Bracketing 2

Selects bracketing parameter to be changed vertically. The
parameters that can be selected are the same as those for
Bracketing 1. (The same parameter cannot be selected for
Bracketing 1 and Bracketing 2.)

Bracketing 2 steps

Selects variable step of bracketing parameter to be
changed vertically. The range of the variable step depends
on the selected bracketing parameter.

[Enlarge image] tab

Enlarge image refers to printing the entire image with the current settings.
After reviewing the parameters with print bracketing, use this tab to make
the settings for the actual print.

Print...

Pit Brackelng [ Erlaige mage |

Displey Mode:

©Entire image.

=
X

OPiint preview

Display Mode

Sets preview method.

Item Description

Entire image Displays entire area of image to be printed and overlaps paper
area and print area.

Print preview Displays only area of image to be printed.




Page Setup
Sets the paper size, margins and other settings.

Item Description
Print Area Sets the paper size and margins.

Standard size : Sets the paper size (Photo (89 x 127 mm)/
(3.5 % 5in.), Postcard (102 x 152 mm)/(4 x 6
in.), Photo (127 x 178 mm)/(5 x 7 in.), Photo
(203 x 254 mm)/(8 x 10in.), Photo (254 x 305
mm)/(10 x 12 in.)). The image size for
printing is automatically adjusted according
to the selected paper size.

Scaletofit  : Sets paper size according to paper used by
printer. [Margins (mm)/(in.)] can be set. The
image size for printing is automatically
adjusted according to the selected paper size
and margins. Alternatively, select [Fit to
paper] to ignore the [Margins (mm)/(in.)]
settings and adjust the image size for printing
to the maximum print area of the printer.

Margins (mm)/(in.):

Sets top, bottom, left and right margins in
units of mm or inches when [Scale to fit] is
selected.

Layout Sets segmentation method of print area. Select from the
following two settings.

No cropping : Prints entire image. Margins are added to
sides or top and bottom depending on print
area and aspect ratio.

Cropping : Prints image without margins. Sides or top
and bottom of image may be cut depending
on print area and aspect ratio.




[Print Setup] dialog
Verify printer settings when necessary using the [Print Setup] dialog. Refer
to the printer user's manual for details on printer settings.

® Using the [Print Setup] dialog
Follow the steps below to open the [Print Setup] dialog.
Click [Printer Settings] on the [Print] dialog.

Print...

Pint Backeting Evege mags |

O Pink preview

The [Print Setup] dialog appears.

Print Setup

Frinter
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® Settings in [Print Setup] dialog
The following settings appear in the [Print Setup] dialog.

Item Description
Name Click [Properties] for printer settings.
Paper Size : Selects paper size.
Source : Selects paper feeding method.
Orientation Sets printing direction to portrait or landscape

orientation. Select [Portrait] or [Landscape].

Changing the PENTAX PHOTO Laboratory 3
Settings

’ Select [Options] from the [Tool] menu on the Main panel or
click the [[7 icon on the Tool bar.

The [Options] dialog appears.

Z Click the [General] tab.

Change the settings as needed.

General | Advanced
Folder 1o Lse
@ Folder with original fle
() Awvays use this folder

Item Description

Folder to Use Select from one of two folders to use.
Folder with original file:
The folder with the RAW file is used.
Always use this folder:
Click [Browse] to display the [Browse for
Folder] dialog, and then select the folder to use.




ltem

Description

Status at Startup

Select the status at startup.

Status at last exit:
Maintains the settings last used when the
application was closed. This switches to
[Arrange All] when, for example, the settings
last used cannot be restored due to a difference
in the number or type of monitors.

Arrange All:
All panels to be used are arranged. Display size
is set to Small (default setting), and other
settings are displayed with the status at last exit.

Default : The status for each panel is returned to the
default status.

Show Splash Screen
at Startup

Sets splash screen when PENTAX PHOTO Laboratory 3
starts.

Yes : Splash screen is shown.

No : Splash screen is not shown.

Arrange Panels

Specify the positioning of panels with automatic

arrangement.

Align right:
Panels are aligned along the right side.

Align left:Panels are aligned along the left side.

Put in Secondary Monitor Except Preview:
The White Balance panel, Tone panel, Other
Settings panel, Lens aberration correction
panel, and Noise Reduction panel are aligned
in a secondary monitor while only the Preview
panel is displayed in the primary monitor.

Initialize Parameters
when Creating a New
File

In PENTAX PHOTO Laboratory 3, sets whether to
initialize all Custom Processing parameters when
opening a new image file.

Yes : Resets parameters.
No : Does not reset parameters.
Display Alerts Sets whether to display alerts.
Yes : Displays alerts. (The “In the future, do not show

this message” check box is not checked for all
alerts.) To change the display setting for
individual alerts, set this to [Yes] and then
check the “In the future, do not show this
message” check box for the alerts you do not
want to show.

No : Does not display alerts. (The “In the future, do
not show this message” check box is checked
for all alerts.)




3 Click the [Advanced] tab.

Change the settings as needed.

General | Advanced
Working Color Space

@ Nomal Display © Simulated wide gamut display

Item Description

Working Color Space  In PENTAX PHOTO Laboratory 3, sets working
(preview) color space (color management). Select from
the following settings.

Normal Display : Displays the image with the color
management set for the image.

Simulated wide gamut display:
Select this option to preview tonal
expression, available only with the
Adobe RGB gamut, in an sRGB
environment. The expressive range of
AdobeRGB, which has a wider color
range than that of sRGB, is
compressed to an sRGB area, which
has a narrower color range than that
of AdobeRGB, and is displayed with
lower overall saturation.

Color Space Sets the color space used when processing an image
with PENTAX PHOTO Laboratory 3.
RAW file setting : Images are processed with the color
management set for the image.

sRGB : Processes the image using sRGB.
AdobeRGB : Processes the image using
AdobeRGB.

When viewing images processed with AdobeRGB in an sSRGB environment,
the saturation may appear lower than when processed with sRGB.



_ @

ltem

Description

Processing

Select from starting processing jobs immediately or
creating a queue list and starting jobs later.
Start immediately: Jobs are started immediately. Other

operations cannot be performed
until processing is completed.

Use queue list : Jobs are added to a queue list. Jobs

may be added or deleted before or
during processing.

Refresh Preview

Real time

: Set this to apply processing
conditions to the preview image upon
each change made to [Custom
Processing] settings.

Refresh button: Set this to apply processing

conditions to the preview image after
all changes are made to [Custom
Processing] settings, upon clicking
the [Refresh] button.

Saving Multiple Files

Select the saving method when processing multiple
images, from the following choices: [Original file name
+ new extension], [Numbered files] and [Save one at a

time].

Select [Numbered files] to specify the base file name
and the number of following digits.

Units

mm

in.

: Sets units of length displayed in
dialogs to millimeters (mm).

: Sets units of length displayed in
dialogs to inches.

4 After setting each item, click [OK].

The options are set, and the dialog closes.
Click [Reset] to return all options to default settings.

m When [Reset] is clicked, all tab settings including the settings of the currently
open tab are returned to default settings.



Glossary

AdobeRGB

This color space is recommended for commercial printing and document
creation by Adobe Systems. Its color reproduction range is larger than
sRGB and adequately covers the color reproduction range for printing.
Therefore, color data only reproducible on a printer are not lost when
editing on a computer. Note that using AdobeRGB with unsupported
software causes colors to appear faint.

CSV format

This data format lists recording fields and separates them with a comma
(,)- Generally, character strings are indicated with double quotation marks
in CSV format. Some software include data input and output functions in
CSV format as part of a multipurpose format.

DNG RAW File

DNG (Digital Negative) RAW is a general-purpose, publicly-available
RAW file format designed by Adobe Systems. When images captured in
proprietary RAW formats are converted to DNG format, support and
compatibility for the images increase significantly.

Exif-JPEG format

Exif stands for Exchangeable Image File Format. This image file format is
based on the JPEG image data format, and allows thumbnail images and
image properties to be embedded into the data. Software that does not
support this format processes the image as a regular JPEG image.

Exif-TIFF format

Exif stands for Exchangeable Image File Format. This image file format is
based on the TIFF image data format, and allows thumbnail images and
image properties to be embedded into the data. Software that does not
support this format processes the image as a regular TIFF image.

JPEG

An image compression format. Although the image quality deteriorates a
little, images can be compressed to a smaller file size than with TIFF and
other formats.




Lossless rotation

Because JPEG uses irreversible compression (data are lost during
compression), the quality of JPEG images deteriorates when uncompressed,
rotated and then saved. Lossless rotation, however, can be used to rotate
JPEG images without recompressing the data. Exif and other data are
maintained. Images for which lossless rotation is performed are processed as
separate files; the rotated image appears after the image file is saved.

PNG format

Images saved using this format can be compressed to a small file size, but
the reversible compression of this format makes the file size larger than
JPEG. This format is for use with full-color images and prevents quality
loss even when re-edited. PNG files, however, cannot be viewed on older
browsers (Internet Explorer 3.0 or earlier or Internet Explorer 4.5 on
Macintosh). In addition, thumbnail images and image properties cannot be
embedded in the data.

RAW data

Unedited image data output from the image sensor. RAW data are data
before being internally processed by the camera. Camera settings at the
time of capture, such as White Balance, Contrast, Saturation, and
Sharpness can be set for each frame after shooting. In addition, RAW data
are 12 bit data that contain 16 times the information of 8 bit JPEG and TIFF
data. Rich gradations are possible. Transfer RAW data to your computer
and use the provided software to create image data with different settings,
such as JPEG or TIFF.

Spurious Color Signal

Occurring in the vicinity of clearly defined lines or fine patterns, this signal
results in the appearance of colors that are not a part of the original subject
or scene. This phenomenon occurs because each individual pixel on
single-plate image sensors (CCD, CMOS, etc.) is capable of reproducing
just one color (Red, Green, or Blue).

sRGB (standard RGB)

An international color space standard defined by IEC (International
Electrotechnical Commission). This is defined from color space for
computer monitors and is also used as the standard color space for Exif.



TIFF-8

A file format for saving image data. Each image is recorded with 8-bit RGB
data for each color. The image is not compressed leaving the file size
large, but no deterioration of image quality occurs.

TIFF-16
Although TIFF images are usually 8-bit, this is a 16-bit TIFF. More computations
are required when image processing as the dynamic range is larger.
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